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Getting started
Welcome to LandDesigner 3D, a fun, fast way to design a landscape or garden. You can create a new 
landscape plan from the ground up, redesign an existing yard, or simply add new plants. 

LandDesigner 3D provides hundreds of trees, shrubs, flowers, and hardscape features for your 
designs. 

What do you want to do?
Take the Guided Tour 
View sample designs 
Take the Quick Start tutorial 
Navigate the Designer 



Take the Guided Tour    
The first time you open LandDesigner 3D, the Guided Tour plays. This tour is a series of narrated, 
animated tutorials that help you understand LandDesigner 3D. If you’re a new user (and if you have a 
sound card), we recommend that you take the Guided Tour before you begin your own designs. 

You have access to this tour at any time by clicking the button in the Guide tab at the left side of the 
window.

 
Note: If you want LandDesigner 3D to play the Guided Tour each time you enter a new design step or 
new window, leave the Autoplay Guided Tour option selected in the Welcome screen. This option also 
appears in the Help menu. When selected, the option appears with a check mark.



Start
This phase welcomes you to LandDesigner 3D by offering three introductory videos and interviews you
about your garden. 



Site
This phase helps you lay out your yard, including the lot, a representation of your house, the slope of 
your lot, and roads and driveways. You can also insert symbols to indicate problem areas and points of
interest. 



Design
This phase helps you through the main part of your design work. Add hardscape, structures, plants, 
beds, and irrigation. You can also use the Dynamic F/X (effects) to see how shadows affect your plan 
and how your plants will grow over time.



Finish
Within this phase you can print your design, view the list of materials in it, and see a reading list for 
learning more about landscape design.



View sample designs
The sample designs are a few examples of what you can do with LandDesigner 3D. We recommend 
that you examine some sample designs before creating your own. You can also use a sample design 
as a starting point for a landscape design of your own.

To look at a sample design in LandDesigner 3D:
1. Select Open Sample from the File menu.

The Sample Files window appears. 

2. Click a listing that interests you and then click OK.
After a short pause, the sample design appears in the Designer.



Navigate the Designer
The Designer is the main window in LandDesigner 3D, where you create and visualize your designs in 
two and three dimensions.    Click on an area in the screen to see what each tool does.

 

See also:

Using the Object toolbar in Top View 
Moving around in the 3D View 
Moving the camera 
Using layers 



Use the Object toolbar in Top View
If you click the Top View tab in the Top View toolbar, the Object toolbar at the bottom of the screen 
displays options for working within Top View.

 
In Top View, the Object toolbar tools let you add plants and other objects to your design. See Add plants 
and Add objects for details on using these tools.
When you select the 3D View, the Object toolbar displays options for moving around in 3D. See Move 
around in 3D View for more information.



Move around in the 3D View
Use the 3D View to see a realistic rendering of your landscape design in three dimensions. The 
WalkAbout tools let you move through the design and view it from all angles. 

 
The 3D View toolbar is divided into four sets of tools for navigating the 3D View.
View. Click the two View icons to switch between an overhead view (helicopter icon) or an eye-level view 
(person icon).
Move. Click a navigation arrow to move in the direction indicated by the arrow. Hold down the mouse 
button to continue the movement.

Height. To adjust your viewing height, click the Up and Down arrows.

Tilt. Click the Tilt icons to adjust your viewing angle.

You can change the 3D View in the following ways by clicking and dragging the mouse within the view 
or by using the arrow pad shown in the previous illustration. For best results, start dragging from 
the center of the 3D View or arrow pad.

To move sideways in the 3D View, hold down the Shift key as you drag the mouse. 

To change your viewing height in the 3D View, hold down the Ctrl key as you drag.

Note: The closer the mouse is to the center of the 3D View or arrow pad, the slower your movement. 
Dragging the mouse away from the center increases your speed.

Using the keyboard: Press the four arrow keys on the keyboard to move in small, precise increments 
in any of the four directions. To use these arrow keys, you must be in 3D View.



Move the camera

The red camera in Top View is often the best way to see what you want in the 3D View. While the 
WalkAbout tools let you change your view gradually and incrementally, you can move your view to any 
part of the design by repositioning the camera.

To move the camera:

1. Click the Camera icon in Top View.
When you click the icon, the word “Move” appears above the mouse pointer.

2. Hold down the mouse button and drag the camera to the location you want to see in 3D 
View.

 
If necessary, use the Zoom tools to see the camera better. 
+ Zoom: To zoom in on a particular area of the design, click the + Zoom tool in the Top View toolbar, then
drag in the Designer to define the rectangular area. The area is magnified when you release the mouse.
– Zoom: Click the – Zoom button to zoom out from a magnified, enlarged view.
Zoom In: To magnify your view of the entire design, select Zoom In from the Windows menu.

3. To rotate the camera, move the mouse over the spin handle near the camera icon, then click
and drag the mouse to rotate the camera.

4. Go to 3D View by clicking the 3D tab in the Top View toolbar.
The new camera position displays the new perspective in the 3D View.



Use layers
The Visible Layers control in Top View lets you show or hide various aspects of your landscape design.
You might want to turn off the display of some items if your machine is running slowly or your design 
becomes congested. 

To use the Visible Layers option:
1. If necessary, move to Top View by clicking the Top View tab in the Top View toolbar.
2. Click the Visible Layers button in the Top View toolbar.

The list shown in step 3 appears. If a layer appears with a check mark, it appears in your design. 
Each item in the list is a toggle, meaning that you turn it on or off each time you select it.

3. Turn the display of the following items on or off.
Foliage. When selected, plants are shown with full foliage. If you turn this option off, plants appear 
as circles. Turn the Foliage display off if your machine is running slowly or if your design appears 
cluttered. Turning off the foliage layer has the greatest effect on speed of processing.

Slope Detail. When selected, the ground displays any mounds or holes you applied. If you turn this
option off, the mounds and holes disappear.

Utilities. When selected, the locations of all utilities such as property lines and water lines are 
shown in Top View. If you turn this option off, the utility symbols disappear.

Sprinkler Coverage. When selected, sprinklers appear with their coverage areas. If you turn this 
option off in Top View, the sprinklers appear without coverage areas. Sprinkler coverage areas can 
appear as circles or pie shapes.

Plant Labels. By default, LandDesigner 3D assigns labels to all items placed in your design. When 
the Plant Labels option is selected, these labels appear with their items in Top View. If you turn this
option off, the labels disappear. The Plant Labels option is off by default.

Your Notes. When selected, any notes you added to Top View are shown with the design. If you 
turn this option off, your notes are no longer displayed.



Save your design
When you reach a stopping point in your design, you can save it for later use. It’s a good idea to save 
your design regularly once you know you want to keep it.

To save your design in LandDesigner 3D:

1. Select Save from the File menu.
You see the Save dialog box.

2. Enter a name for your design in the File Name field.
3. If necessary, assign the design file to another directory on your drive.

By default, your design files are saved to the C:\Sierra\LandDesigner 3D\Design directory. 
LandDesigner 3D gives the file a .3dl extension.

Use the navigational controls in the Save window to change directories. See your Windows 
manuals if you need more information.

4. Click Save to save the design file.

Note: If you try to exit LandDesigner 3D without saving your work, you are prompted to save the 
design first.

To save your design as a sample in LandDesigner 3D:

1. Select Save as Sample File from the File menu.
2. In the next window, type a name for the sample and click OK. 

The design you created is now available at any time when you select Open Sample from the File 
menu and select the My Samples tab.



Share your design
Three commands in the File menu let you share your design with others by exporting it as a bitmap or 
sending it via e-mail.    You can also share your design with another LandDesigner 3D user over the 
Internet.

What do you want to do?
Export your design 
E-mail your design    
Use Internet Walkthrough and Design Sharing 

Note: You can use the Recorder feature to show snapshots and animated Walkthrough tours of your 
design to other people. For more details, see Record Walkthroughs and Snapshots.



Print your design
LandDesigner 3D gives you several options for printing your landscape design.

If you select the Finish phase in the Step-by-step toolbar and then click Print Plans, the Designer 
gives you options for printing the Top View, the 3D View, or a list of plants and materials used in your 
landscape design. Click the option you want, then click OK in the resulting window to print the view or 
list.

If you don’t want to use the Step-by-step toolbar, you can print your design at any time by following the
steps below.

To print your design in the Top View:

1. Select Print from the File menu.
The print options dialog opens.

2. Select the desired scale for your printout.
Enter a title, if desired. Click OK.

3. In the resulting window, you can specify a printer, paper orientation (landscape or portrait), 
and the type of paper to use. Click the Properties button to select advanced printing 
settings.

4. Click OK to print.



Export a design
If want to incorporate the snapshot of your 3D View into another document, use the Export Bitmap 
command in the File menu. LandDesigner 3D saves the 3D view as a two-dimensional Windows 
bitmap. 

To export your design as a bitmap:
1. Click the 3D tab in the Top View toolbar to go to 3D view.

You cannot export the Top View as a bitmap image.

2. Select Export Bitmap from the File menu.
3. In the Save window that appears, enter a name for the file in the File Name field.
4. If necessary, assign the file to another directory.

Use the navigational controls in the Save window to change directories on your drive. See your 
Windows manuals if you need more information. By default, the file is saved to the C:\Sierra\
LandDesigner 3D directory.

5. Click Save to save the file.
Note in the Save as Type field that your image will be saved as an 8-bit Windows bitmap.



E-mail your design
If you have a modem and a MAPI-compliant e-mail such as Microsoft Exchange or Outlook, 
LandDesigner 3D also allows you to e-mail your designs to others. For others to view your design they
must also have LandDesigner 3D.

To e-mail your design:
1. Open the design file in LandDesigner 3D.

Choose Open from the File menu and locate the file. Your design appears in the Designer.

2. Select Mail This Design from the File menu.
If you do not have an e-mail program or a modem, do not use this command; it may crash your 
system.

3. Click OK in the resulting windows until the e-mail window appears.
4. Send an e-mail message as you normally do.

Your design is sent with the e-mail as an attachment. 



Create your design
This section explains the Step-by-step toolbar in LandDesigner 3D, which guides you through the 
steps of building your design.

What do you want to do?
Use the Step-by-step toolbar
Get help as you work 
Start your design 
Define the site 
Lay out the design 
Finish the process 



Use the Step-by-step toolbar
To help you proceed logically through the design process, LandDesigner 3D has a Step-by-step 
toolbar. 

 
This toolbar contains four main phases—Start, Site, Design, and Finish. When you click a phase, the 
toolbar changes to display actions within that phase. For example, click Site to work with your lot, house, 
slope, symbols, and roads/driveway.
We want to emphasize that the Step-by-step toolbar is a guide to using LandDesigner 3D. It is not 
mandatory that you use its steps in order, or use it at all. 

As you click through the steps in each phase, you may find activities that don’t interest you. If so, you 
can skip them. To skip ahead within a selected phase, simply click on the yellow arrow at the end of 
the toolbar to move to the next step.    You can also click in the Next Step button.

The toolbar consists of the following design phases:

Start. This phase offers three introductory videos for using the program and interviews you about your 
yard.    See Start your design.

Site. This phase is where you lay out your landscape site, including the lot, house, slope, and roads 
and driveways.    See Define the site.

Design. This phase helps you add and position plants, structures, and other objects in your design.    
See Lay out the design.

Finish. This phase is where you print your design, view the list of materials in it, and see a 
recommended reading list on landscape design.    See Finish the process.

Experienced users can skip the Start phase and go straight to the Site phase in the Step-by-step 
toolbar. You can change menus in the Object toolbar at any time to drag plants and objects of interest 
into your design.



Get help as you work

Guide tab  
If you need help with any of the steps in the Step-by-step toolbar, click the Guide tab at the left side of 
the window for more information. For a narrated explanation, click the media button in the Guide tab.

Design Guide  
For landscaping tips and design information, use the Design Guide. Select Options in the Design 
Guide menu or click the Design Guide button. For example, choose Chapters from the Design 
Guide menu and then choose Chapter 2 or 3 for information on laying out and designing your site.

Step-by-step toolbar tips
For the most part, steps within the Step-by-step toolbar take one of two forms.

Wizards: When you click a step marked with the wizard symbol, LandDesigner 3D uses a “wizard” 
format to help you through the step. A wizard is a series of windows that guide you through a process 
and ensure that you make the necessary selections to perform the task. To move to the next window of
a wizard, click Next Step. To move to the previous window of a wizard, click Back.

Object toolbar: In some steps you add plants and objects from the Object toolbar. In these cases, the 
Object toolbar changes to display appropriate items for the selected step. For example, the Plants 
menu appears when you click Plants within the Design phase. You can then drag these plants into 
your design. You can also change the menus yourself (in non-wizard steps) to display other items.

For details on adding plants to your design, see Add plants. For details on adding other objects, see 
Add objects.



Start your design
To begin your design, select the Start phase in the Step-by-step toolbar. You have two options in the 
Start phase:

Welcome. The Welcome screen lets you select three introductory videos that help you use 
LandDesigner 3D. 

Interview. When you click Interview, LandDesigner 3D presents seven questions about your 
gardening conditions and objectives. Your answers help LandDesigner 3D customize the program 
according to your needs. For example, your answers will customize the plant options that appear in the
Object toolbar. Your answers also determine the default zone and soil settings for searches in the 
Plant Finder.

Question 1 in the interview lets you specify your garden zone. USDA hardiness zones subdivide the 
U.S. according to minimum temperatures at which plants can survive. If you don’t know your zone 
number, click Map and then click your zone in the map.    See USDA Hardiness Zone Map for 
instructions.

When you finish the first four questions, click Next Step to see the last three questions. Click Done to 
move to the next phase.



USDA Hardiness Zone Map
The Zone map displays USDA hardiness zones, which subdivide the U.S. according to minimum 
temperatures at which plants can survive.    You can either set your zone in either of two ways:

· Click on any region in the continental United States

· Enter your zipcode and press the Set Zone from Zipcode button.

 



Define the site
To define the site in your landscape design, select the Site phase in the Step-by-step toolbar. The Site 
phase consists of five options:

Lot. Click this button to open the Lot Wizard, in which you define the dimensions, property lines, and 
compass setting of your lot.

House. Click this button to open the House Wizard, which takes you through the steps of representing 
your house in the design.

Slope. This wizard helps you define the slope of your lot.

Symbols. Insert symbols that indicate problem areas and points of interest on your lot, such as wind 
direction, noise problems, and eyesores.

Roads/Driveway. Define roads and driveways on your lot.



Define the lot
When you click the Lot button in the Site phase, the Lot Wizard takes you through the following three 
steps to define your lot. Click Next Step to move through the wizard.

Setting the lot’s dimensions. Define the width and depth of the scene in the appropriate fields. To 
specify a background and ground cover for the design, click the Change 3D Ground or Change 3D 
Backdrop button. For more details, see Change backgrounds and ground covers.

Laying down the property lines. Drag a property line tool from the Object toolbar into the design and 
define a custom shape that represents your property lines. 

 
Setting the compass. Rotate the compass to point north and properly situate your design. To rotate the 
compass, click on it in the Designer. The dot that appears with the compass is the spin handle. Hold the 
mouse pointer over the dot, then click and drag the mouse to rotate the compass.

 



Define your house
The House Wizard helps you quickly build a facsimile of your home in the landscape design. To begin, 
click the House button in the Site phase to see Step 1 of the House Wizard.

The House Wizard has seven steps. After each step, click Next Step to move through the wizard.

To create a representation of your house in the design:
1. Select a template to define the basic shape of your house.

You can click one of the three displayed templates, create a custom shape, or click the Sample 
Home button and select a finished home from the resulting list. If you select a custom shape or a 
finished home, skip to step 4.    

In choosing a template, choose the closest footprint for the main portion of your home.    You’ll be 
able to add extra rooms later.

2. Determine the size and orientation of the house.
Each side of the house is identified with a letter. To change the length of a side, type a new length in
the field of the corresponding letter. To rotate the house shape or flip it horizontally or vertically, click
the Rotate or Flip buttons.

 
3. Define the following roofing and siding options:

a) Select Gable, Hip, or Flat as the roof type.

b) Drag the slider bar to determine the slope of the roof.

c) Click Yes if you want the roof to have an overhang.

d) Set the number of stories for your house.

e) Click a Material button to determine the texture of the walls, roof, and trim. The Choose 
Materials window opens. If you need help using this window, see Add colors and textures. 

4. Add more blocks, if necessary, to complete the basic structure of your house.
For example, you can add a garage to the house. Drag these blocks from the Object toolbar into the
design, then resize the blocks by dragging the arrows around them. To rotate a block, click it to 
select it, then click and drag the spin handle that appears above it.

The Spec Sheet can help you revise your home design. To open the Spec Sheet, double-click a 
house block in Top View. You can also select a block, click the Mini View tab, and change settings 
in the miniature Spec Sheet that appears.

To change the height of the walls in a block, change the setting in the Height field of the Spec 



Sheet.

To raise a block, change the setting in the Height Above Ground field of the Spec Sheet.

The wall and roof settings in the Spec Sheet correspond to your selections in the previous step of
the House Wizard. You can change these settings if necessary.

For more details on using the Spec Sheet, see Using Spec Sheets.

Once you finish adding blocks, preview your home design in 3D by clicking the Mini View tab. If 
necessary, revise the house until you are satisfied with the basic shape.

5. Add windows and doors to the house.
First, click the Mini View tab to display a tracking tool that helps you navigate around the house 
and find the spots where you want to add windows and doors. 

Click in the Mini View window on the circular track to move the camera on the track or click and 
drag the camera around the circle to rotate your view. Your vantage point of the house changes in 
3D View. 

 
When you’re working in 3D View, you can choose Mouse WalkAbout in the Top View toolbar to walk 
around the house and find the best view, or Mouse Edit Objects to place and edit doors and windows.

Drag doors and windows from the Object toolbar onto a wall of the house. Click the menu in the 
Object toolbar to change your selection from doors to windows.

Note: This is the only place in LandDesigner 3D where you can directly place or move windows and
doors into 3D View. You might have to wait occasionally while the 3D scene rebuilds, or renders. 

In the 3D View of the Designer, you can drag the windows and doors to new locations on the house.
To resize doors and windows, double-click them in the design, then change the Width, Depth, and 
Height settings of the Spec Sheet that appears. You can also use the Mini View Spec Sheet in the 
Mini View tab. For details on using the miniature Spec Sheet, see Use the Mini View Spec Sheets.

To delete a door, window, or entire block from the house design, select the item and press the 
Delete key on your keyboard. To duplicate selected items, use the Copy and Paste commands in 
the Edit menu.

6. Add exterior details such as stairs and a chimney.
Drag these details from the Object toolbar onto the house. Click the menu in the Object toolbar to 
change your selection of exterior details. You can resize these details in the Designer by selecting 
them and then dragging the arrows around them. To rotate a detail, click it to select it, then click and
drag the spin handle that appears above it.

To delete exterior details from the house design, select the item and press the Delete key on your 
keyboard. To copy selected items, use the Copy and Paste commands in the Edit menu.

You can also use the Spec Sheet to alter these exterior details, as described in the previous steps. 
For example, use the Height Above Ground setting to change the elevation of dormers and 
chimneys.

7. Finish the house by positioning it on the lot.



To reposition the house, click and drag it in the Top View of the Designer. 

To revise the house, you can click Back to return to previous steps in the House Wizard. Click 
Done when you are finished. You can also revise the house at any time by double-clicking it in the 
Top View of the Designer and changing the settings in the House Wizard.

Note: To edit the house after you leave the House Wizard, double-click the house. Click OK when 
you see a message explaining you will return to the House Wizard. (The rest of your landscape 
becomes invisible). Edit your house blocks in Step 4, edit your windows and doors in Step 5, and edit 
any extra details in Step 6. When you complete the House Wizard, your landscaping reappears. 



Define the slope of your lot
The Slope Wizard lets you create slopes and grades on your lot.

To define the slope of your lot:
1. Click the Slope button in the Site phase to see Step 1 of the Slope Wizard, then define the 

basic slope of the lot.
· Set the maximum ground height of the grade at the top of the slope.

· If your lot has one predominant slope, click the up and down arrows on the appropriate side(s) 
of the lot to mimic the slope.

· Use the text boxes to specify the height of any side of the slope.

· To return the site to its original state, click the Reset Tilt button.

2. If your lot is terraced or has a number of rolling slopes, you can click the Advanced button.
Advanced slopes are optional. If you click Advanced, use the resulting shape to define the slopes 
or terraced effect across one plane of your lot. To choose which direction the curve runs through 
your lot, click either the left or bottom button.

Defining a slope

Defining a terrace
Each time you click on the shape, LandDesigner 3D adds a point. You can drag these points to change 
the elevation and define the slope. To delete a point, click and drag it over another point. Use the 
measurement guides that appear when dragging points to help you judge the position of the curve. To 
return the shape to its original form, click Reset Profile.

3. Click Next Step to go to the final step of the Slope Wizard. 
Add holes and mounds to your design by selecting them in the Object toolbar and dragging them to 
the appropriate locations in your lot.

Click the lower menu in the Object toolbar to select hole or mound shapes. You can resize and 
reposition these shapes after placing them in your design.



Use symbols to mark points of interest
Click the Symbols button in the Site phase to insert markers that indicate potential problem areas and
points of interest on your site, such as wind direction, noise problems, and eyesores you want to hide. 
Drag these symbols from the Object toolbar and drop them in the proper place on your site.

 

Note: Symbols do not appear in 3D View.

 

The Design Guide provides information to help you deal with potential problem areas. If you choose 
Chapters from the Design Guide menu and then choose Chapter 2, the resulting window contains 
topics on screening for privacy, buffering noise, and buffering wind. Click a topic to read more about it.



Define roads and driveways
Click the Roads/Driveway button in the Site phase to define drives, patios, and other paved surfaces 
in your design. Drag items from the Object toolbar and drop them in the design. Paved surfaces are 
represented in your design as textures on the ground.

In the design, you can resize and reshape these surfaces as needed. See Define closed shapes for 
more information.



Lay out the design
After you finish defining the site, you’re ready for the most crucial part of your design: adding plants 
and other exterior objects such as decks and arbors and a variety of plants.

Much of your work during this step consists of selecting plants and other objects in the Object toolbar, 
then positioning and reshaping the plants and objects in the Designer.

If you need advice using any of the options in the Design phase, click the Guide tab at the left side of 
the window. 

The Design phase contains six steps:

Hardscape. Hardscape refers to built components of your yard and landscape, such as fences and 
walkway paths. See Drawing you own object shapes for details on adding hardscape to your design.

Structures. See Add objects for details on adding structures such as lawn chairs, arbors, sprinklers 
and other objects to your design.

Plants. For details on adding plants to your design, see Add plants.

Gardens. For details on adding garden beds to your design, see Add garden beds and hedges.

Irrigation. Use this wizard to plan an irrigation system for your design. You can lay out in-ground 
sprinklers or surface drip tubing by dragging their components into the design from the Object toolbar. 
See Irrigation basics for instructions.

Dynamic F/X (Effects). Once you’ve defined the plants, structures, and other objects in your design, 
you can use the Shadow Caster to see how shadows fall across your design in Top View. You can also
project the plants’ Growth Over Time and use the Seasonal Change feature to see how the plants will 
look from season to season. For details on using these dynamic effects, see Use the Shadow Caster,
Project Growth Over Time and Project Seasonal Change.

Note: You can define custom shapes for many of the components you add to your design from the 
Object toolbar. For details on defining custom shapes for plants, see Define ground cover with the 
drawing tool.    For objects, see Draw your own object shapes.



Finish the process
When you complete your landscape design, select the Finish phase in the Step-by-step toolbar. You 
have three options in this phase:

Print Plans. When you click Print Plans, the Designer gives you options for printing the Top View, the 
3D View, or a list of plants and materials used in your landscape design. Click the option you want, 
then click OK in the resulting window to print the view or list. For more details on printing, see Print 
the design.

Shopping List. Click this button to see a list of plants and materials used in your landscape design. 
For more details, see Use the Shopping List.

Resources. If you select this option, LandDesigner 3D displays a list of recommended reading on 
landscape design.



Add plants
This section explains your options for adding and manipulating plants in the Designer. For information 
on adding other objects in LandDesigner 3D, see Add objects.

You'll find two major categories of plants in this software, generic placeholders and specific varieties. 
For example, the product includes generic plants such as Generic Round Tree, as well as specific 
plants such as the Sugar Maple. For more information on selecting types of plants, see Chapter 5 of 
the Design Guide.

To quickly add major plantings to your landscape, use the generic shapes to get the massing you 
want, then refine these with specific plants. Each generic plant can be replaced with a specific one 
once it is in your design. Double-click the plant in Top View to open its Spec Sheet, then click the 
Replace with... button in the window that appears. See Using a plant's Spec Sheet for more details.

You can also add a specific plant directly to your landscape instead of replacing a generic placeholder. 
See Using the Plant Finder for more information. In the Plant Finder, you can search by plant name 
or by attributes. Add the plants you choose to Your Object Bar, then drag them in to the Top View.

What do you want to do?

Add plants from the Object toolbar 
Add plants using the Plant Finder 
Position plants 
Revise a plant using its Spec Sheet
Add your own plant records 
Add garden beds and hedges 
Define ground cover with the drawing tool 



Add plants from the Object toolbar
The Object toolbar lets you quickly add plants to your design. Choose generic placeholder plants by 
type and shape to get the overall plantings you want in your design, then refine these later with 
specific plant varieties. Or look through some of the collections of special purpose plants.

Note: If you already know a specific plant variety you want to add to your design, use the Plant Finder 
to locate the plant and add it to Your Object Bar. See Add plants using the Plant Finder for 
instructions.

To add plants using the Object toolbar:
1. If you are not already in the Top View, please click on the Top view tab.

You must be in Top View to add plants in the Designer.

2. In the Object toolbar, select the plant type you want.
Click the top menu and select Plants from the resulting list. Next, in the second menu, select the 
type of plant you want, such as Trees. By default, the toolbar will display the basic generic shapes 
available for that type of plant. 

 
To view different lists of plants, click the middle and bottom menus. A list will drop down, from which 
you can make a new selection.

Click on the bottom menu to see other options. Some types of plants, such as annuals, offer a wide 
variety of generic shapes, based not only on the overall shape of the plant, but on features such as 
blossom shape. Other types of plants, such as trees, provide lists of specific plants well suited for 
different regions.

 
Note: Not all menus have sub-menus. Also, the menus are hierarchical, meaning that your choice in
one menu determines the options that appear in the menus underneath it.

3. When you find the plant you want for your design, click its icon in the Object toolbar and 
drag it into Top View. 
You can also place the plant in Top View by clicking once on the plant and then clicking once inside 
Top View where you want the plant. 

Note: A brief description of the plant usually appears when you hold your cursor over it in the 
toolbar.

4. When the plant is in Top View, position it properly.
For details, see Positioning plants.

You can replace generic plants with specific plants once you have placed them in your design. For 
details, see Revising a plant using its Spec Sheet. 
Note: To quickly distinguish between generic plants and specific plants, look at their icons in the 
Object toolbar. Specific plants have an inset photo on their icon. 



 

 



Position plants
Use the Top View in the Designer to reposition and resize plants. You use the 3D View to see the 
effects of your work. Any changes you make in Top View apply immediately in 3D View. 

What do you want to do?
Move plants 
Change a plant  ’  s size   
Copy plants 
Delete a plant 



Move plants

Elevation of dropped objects
LandDesigner 3D automatically places most plants on the ground. In some cases, however, you might 
want to change the plant’s elevation. For example, you might want to place a plant in a pot or on a 
deck. For details, see Position decorations and smaller objects.

Moving plants with the mouse
To move a plant to a new location in Top View, place your mouse pointer on it. When the “Move” 
handle appears, select the plant and drag it where you want it. 

Moving multiple plants
To move multiple plants at one time, you have two options:

 
· Choose Drag Select from the Edit menu and then click and drag in Top View over the plants you 

want to move. After you define all the plants, release the mouse. Next, click and drag the mouse on 
one of the plants you selected. All the selected plants will move.

· Hold down the Shift key and click on each plant you want to move. When all the plants are 
selected, release the Shift key. Next, click and drag the mouse on one plant. All the selected plants 
will move.

Moving plants with the keyboard
By pressing the arrow keys on your keyboard, you can incrementally move a selected plant up, down, 
left, or right. Repeat the commands as many times as necessary.



Change a plant's size
Sometimes a plant looks too big, or not big enough, for the design. In such cases you can easily 
change the plant’s size.

To change a plant’s size:

1. Click once on the plant to select it in Top View. 
The small arrows that appear around the plant let you resize it.

2. Hold the mouse pointer over an arrow, then click and drag the mouse to change the plant’s 
size.
To increase the plant’s width and height, drag the mouse away from the plant. 

To reduce the plant’s width and height, drag toward the center of the plant. As you drag, the plant’s 
current dimensions appear in Top View.

If you change a plant’s width, the height changes proportionally, and vice versa.

3. To change a plant’s size using precise dimensions, double-click it and change the 
dimensions in the Spec Sheet.
You can also select a plant, click the Mini View tab, and change settings in the miniature Spec 
Sheet that appears.

For details on using the Spec Sheet, see Revising a plant using its Spec Sheet.



Copy plants
Once you have created and refined a plant, you can copy it. Plants retain all dimensions, colors, and 
materials of the original.

To copy a plant, select it and choose Copy from the Edit menu. Next, select Paste from the Edit 
menu to make the copy appear. Move the copied plant in the design as needed.



Delete a plant
If you decide that a certain plant isn’t right for your design, you can delete the plant. You have the 
following options:

To delete a single plant, click it and then press the Delete key. You can also select Delete from the 
Edit menu. 

To delete multiple plants, hold down the Shift key, click each plant you want to delete, and then 
press the Delete key.

Note: If you make a mistake while resizing or repositioning a plant, you don’t have to delete it and start
over. You can undo the previous action by selecting Undo from the Edit menu.



Add plants using the Plant Finder
The Plant Finder gives you access to LandDesigner 3D’s extensive database of trees, shrubs, and 
greenery. Use this feature to add a particular species to your design, or to replace a generic plant with 
a specific one.

Each plant in the Plant Finder comes with a photograph or illustration, detailed information on size, 
care, and use, and usually, the pronunciation of the botanical name.

To locate a particular plant:

1. Open the Plant Finder using one of the following options:
To locate a plant you can’t find, click the Find button in the Object toolbar.

 
To replace a generic plant with a specific one, double-click the plant in Top View. In the plant Spec Sheet
that appears, click the Replace With button. 
The Plant Finder window appears.

 
2. To search for plants by common name or botanical name, click the By Name button and 

then enter all or part of the name.
3. To search for plants by different criteria and characteristics they possess, click the By 

Attributes button and then select the attributes you want. 
For example, you can click Type, Shape, and Height and select attributes for these categories from
the resulting lists.

After you have chosen a type, representative plant shapes appear when you click the Shape list.

Most attributes are self-explanatory. The Zone button refers to USDA hardiness zones, which 



subdivide the U.S. according to minimum temperatures at which plants can survive. Click the Zone 
button and select your zone from the resulting list. If you don’t know your zone number, click Maps 
from the Zone menu and click your zone in the map.

As you increase the number of search attributes, you decrease the number of plants LandDesigner 
3D finds. If you select too many search attributes, your search will find no plants.

If you completed the interview when you started your design, the default zone and soil settings 
correspond with your answers. For details on this interview, see Start Your Design.

4. To further limit a search to find deciduous plants, evergreens, or previously defined custom
plants, click the appropriate check boxes. 
For details on defining plants of your own, see Add your own plant records.

5. To sort the plants found in the search, click Common Name or Botanical Name.
The Matching Plants list shows which plants LandDesigner 3D found. Scroll through the list to see 
all the matches. The total number of matches is shown above the list.

To erase the search attributes and start again, click Clear.
6. To learn more about a particular plant found in your search, click its name in the Matching 

Plants list and then click the View button. 
The Plant Finder displays a picture of the selected plant and information about it.

Once you select a plant, you have the following options:

· To read a description of the selected plant, click the Description tab. To read about the plant’s 
attributes, click the Attributes tab.

· To see and read about the next plant found in your search, click Next or Prev(ious).

· To define your own custom plants, click New Plant Record. For details, see Add your own 
plant records.

· To return to the Plant Finder window, click the Search button.

7. To add the selected plant to the Your Object toolbar menu in the Object toolbar, click Add to
Toolbar.    
To add multiple plants, double-click each one in the Matching Plants list so check marks appear 
next to them, then click Add to Toolbar. You can also click the check boxes themselves to select 
multiple plants.

8. When you finish using the Plant Finder, click OK.
If you entered the Plant Finder through the Find button on the Object toolbar, you return to the 
Designer. If you added plants to the toolbar, the Your Object toolbar menu appears with the plants 
you specified. You can then drag them into your design.

 
Note: The Your Object toolbar menu retains the items found in all searches until you exit LandDesigner 
3D. If the menu becomes too congested, you can clear it by selecting Clear Your Object toolbar from the
Edit menu. Your Object toolbar automatically resets whenever you exit the application.



Revising a plant using its Spec Sheet
You can use a plant’s Spec Sheet to revise its size, appearance, and other properties. 

Note: If you click the Mini View tab, a miniature version of the Spec Sheet appears in the Mini View on
the left side of the window. You can see the plant’s name and revise the plant’s width, height, and 
color. To open the full-sized Spec Sheet from this miniature version, click Details. 

1. To open a plant’s Spec Sheet, double-click the plant.
You can also right-click the plant and then select Specs from the menu that appears.

The Spec Sheet includes the current settings for the selected plant. You can revise any or all of 
these settings.

2. To open the Plant Finder and replace the selected plant with another, click the Replace With
button. You can use the Replace With button to replace a generic plant with a specific 
variety.

3. Set the plant’s dimensions by entering values in the Width and Height fields.
4. To return the plant to its original dimensions, click the Original Size button. 

Some plants also have a list of Suggested Sizes in the Spec Sheet. If so, you can choose a size 
from the list.

5. If you are satisfied with the size and location of a plant, you can lock its settings to make 
sure they aren’t changed accidentally.

To lock the plant’s size, click the Lock Size box.

To lock the plant’s size and location, click the Lock Size and Location box.

6. To assign a plant a different flower color, click the Flower Color list and select a color.
7. To display the plant by its size at a certain age, enter an age and then click Size Based on 

Age.
The plant’s height and width will change, but the amount of its branches and foliage will not.

8. Click the other tabs in the Spec Sheet to view more information about the selected plant.
By default, the Basics tab appears, as shown in the previous illustration. Click the Plant Info tab, for
example, to see descriptions and attributes of the selected plant. For details about the options in the
other tabs, see Using Spec Sheets.

9. Click OK to close the Spec Sheet and return to the Designer.



Add your own plant records
If you can’t locate the plant you need in the Object toolbar or the Plant Finder, you can define it 
yourself and add it to LandDesigner 3D.

To add your own plant record:

1. Open the Plant Finder by clicking the Find button in the Object toolbar.
2. Click the New Plant Record button in the Plant Finder.

You see the Add My Own Plant window.

3. In the Common Name field, type the name of the plant you want to add.
4. Click the Type and Shape buttons and select the closest matching plant type and shape 

from the resulting menus.
5. To further customize your plant, enter other attributes under Optional Information.
6. To associate a scanned photograph or bitmap to your custom plant record, click Choose 

Photo and select the graphic from the file navigation window.
If you want to delete your custom plant selections and start over, click Delete This Plant.

7. When you finish defining the custom plant, click OK.
The Plant Finder appears with the custom plant selected in the Matching Plants list. Be patient; this 
operation might take a few seconds.

8. To add the selected custom plant permanently to the Object toolbar, click Add to Toolbar in 
the Plant Finder.

9. Click OK to exit the Plant Finder.
If you entered the Plant Finder through the Find button on the Object toolbar, you return to the 
Designer. If you entered through the Spec Sheet, the custom plant you selected in the Plant Finder 
becomes the new selection in the Spec Sheet.

To change information about a custom plant later, open its Spec Sheet and click Change Custom 
Info.



Add garden beds and hedges
If you want to quickly lay out an entire bed of plants rather than painstakingly selecting and plotting 
individual plants, use the Garden Bed wizard.

To begin adding a garden bed, select the Design phase in the Step-by-step toolbar and then click 
Gardens. A selection of garden bed shapes appears in the Object toolbar. Use the wizard to lay out 
the bed. If you need help, click the Guide tab at the left side of the window. 

To add a garden bed to your design:
1. Define the shape of the bed and drag it into the Designer.

This is Step 1 of the Garden Bed wizard. You have several options:

Pick the desired shape of garden bed from the options in the Object toolbar and drag it into the 
Designer. You will define its size and shape later.

If the shape you want is not available, use the Free Draw Bed option. Click the Draw Type button 
and pick from one of the following shapes:

· Select the rectangular or circular shape and drag to define the size of the shape. When you 
finish, the object appears.

· Select the Point-to-Point Curve tool. 

Each time you click in Top View, you define one curve of a free form, curved shape. Continue 
clicking until you define a closed shape. To end the shape, double-click on the last point or press 
the Esc, Enter, or Backspace key. The shape fills in.

· Select the Point-to-Point Line tool. 

Each time you click in Top View, you define a side of a free-form shape. Continue clicking until you 
define a closed shape. To end the shape, double-click on the last point or press the Esc, Enter, or 
Backspace key. The shape fills in.

2. Once the garden bed is in the Designer, reposition it and reshape it as necessary.
Again, you have several options:

· To move the bed, hold the mouse pointer within it. When the “Move” handle appears, click and 
drag the bed where you want it.

· To resize the entire bed, click and drag over one of the outer arrows.

· To reposition one of the bed’s points, hold the mouse pointer over one of the inner arrows. 
When a “Stretch” handle appears, click and drag the point to a new location. 

· To reposition one of the bed’s sides, hold the mouse pointer over one of the inner arrows. When
a “Pull” handle appears, click and drag the side to a new location. 

· To rotate the bed, click the dot within it. When a “Spin” handle appears, click and drag the 



handle to rotate the bed. 

· You can also reshape the bed by right-clicking the “Pull” handles of particular points and using 
the resulting menu options. See Edit points of objects for more details.

3. Click the Next Step button to move to Step 2 of the Garden Bed wizard.
In this step, you add plant clusters to fill the bed.

4. Drag plant clusters from the Object toolbar into the bed you defined.
5. Click the Next Step button to move to Step 3 of the Garden Bed wizard.

· If you added predefined clusters of plants to your garden bed in the previous step, you can use 
this step to revise individual plants within the clusters.

· Go to the Generic Shapes menu and drag in generic plants that you can replace later with 
particular species. For more details, see Using a plant's Spec Sheet.    

· Use the Plant Finder to locate specific plants, add them to Your Object Bar, and drag them into 
your garden bed. See Using the Plant Finder for more details.

 
· To quickly create a row of one type of plant, select the plant on the Object toolbar, click the 

Draw Type button, and then click the Hedge button. Move your mouse to Top View, click to 
select the first point and click where you want it to end. The hedge draws when you release the 
mouse.

6. To change a cluster of plants, right-click on the bed and select Ungroup. 
You can also select the bed and then select Ungroup from the Edit menu. The plants in the bed 
become independent. You can then resize, reposition, or delete individual plants as needed.

If you want to regroup the plants into a cluster after you finish, click the Drag Select button and 
drag over the group. Next, select Group from the Edit menu. 

7. Click the Next Step button to move to the last step of the wizard and apply edging to the 
garden bed.
Select the type of edging you want from the Object toolbar, then move your mouse to Top View and 
define the edging shape. Each time you click in Top View, you define a point of the shape. Continue
clicking until you define the shape you want. To end the drawing, click on the last point, right-click, 
or press the Esc, Enter, or Backspace key. 

If you need to revise the shape of the edging, see the options in step 3 of this procedure.

8. Switch to 3D View and review your design.
Click the 3D tab in the Top View toolbar to go to 3D View. If changes are needed, return to Top View
to make them.



Define ground cover with the drawing tool
Besides all the tools for adding generic and specific plants, LandDesigner 3D lets you quickly define 
an area of any shape or length and assign it a vine growth or ground cover.

To define a ground cover area with the drawing tool:
1. Select any generic ground cover plant in the Object toolbar.
2. With the plant selected, click the Draw Type button and then define the ground cover area 

you want. 
3. Select one of the following Draw Types from the menu and define the shape in Top View.

· Select the rectangular or circular shape and drag to define the size of the shape. When you 
finish, the object appears.

· Select the Point-to-Point Curve tool. 

Each time you click in Top View, you define one curve of a free form, curved shape. Continue 
clicking until you define a closed shape. To end the shape, double-click on the last point or press 
the Esc, Enter, or Backspace key. The shape fills in.

· Select the Point-to-Point Line tool. 

Each time you click in Top View, you define a side of a free-form shape. Continue clicking until you 
define a closed shape. To end the shape, double-click on the last point or press the Esc, Enter, or 
Backspace key. The shape fills in.

3. If necessary, reshape and resize the plant area in Top View.
To move the plant area, hold the mouse pointer within it. When the “Move” handle appears, click 
and drag the plant area where you want it.

To resize the entire plant area, click and drag the mouse pointer over one of the outer arrows.

To reposition one of the area’s points, hold the mouse pointer over one of the inner arrows. 
When a “Stretch” handle appears, click and drag the point to a new location.

To reposition one of the area’s sides, hold the mouse pointer over one of the inner arrows. When
a “Pull” handle appears, click drag the side to a new location. 

To rotate the area, click the dot within it. When a “Spin” handle appears, click and drag the handle 
to rotate the area. 

You can also reshape the area by right-clicking the “Pull” handles of particular points and using the 
resulting menu options. See Add and remove points of objects for more details.

4. Switch to 3D View and review your design.
Click the 3D tab in the Top View toolbar to go to 3D View. If changes are needed, return to Top View
to make them.





Add objects
You can add other objects besides plants to your landscape designs. For example, you can add lawn 
chairs, sprinklers, and barbecue grills. This section explains how to use these objects in your designs.

What do you want to do?
Find objects 
Position objects 
Use an object  ’  s Spec Sheet   

Add colors and textures 
Reshape objects 
Draw your own object shapes 
Import a deck from 3D Deck 
Create your own objects 
Create your own textures 
Digital collections 



Find objects
You can locate objects you want to use in your landscape designs by using the menus in the Object 
toolbar or by clicking the Find button and using the Object Finder.

The Step-by-step toolbar helps you add objects at the right time and also takes you to the right menus 
for selecting objects of interest. In some steps, the Object toolbar is not available. See Use the Step-
by-step toolbar for details.

What do you want to do?
Find objects in the Object toolbar 
Search for objects 



Find objects in the Object toolbar

1. If necessary, click the Top View tab in the Top View toolbar to go to Top View.
You must be in Top View to add objects in the Designer.

2. In the Object toolbar, click the first menu and select the type of object you want to add.
For example, you can click the menu and select Accents from the resulting list. The related accent 
items appear in the Object toolbar to the right of the menus.

To see more objects, you can stay within the Accents menu or switch to a different category.

To stay within the Accents menu and view different objects, click a menu below it. A list drops 
down, and you can make a new selection. Note that not all menus have sub-menus.

To switch to a different category, click the top menu again and make a different selection, such 
as Furniture or Structures. Note that the menus are hierarchical, meaning that your choice in a 
menu determines the options that appear in the lower menus.

A brief description of the object usually appears when you hold your cursor over it in the toolbar.

3. When you find the item you want for your design, click its icon in the Object toolbar and 
drag it into Top View. 
You can also place the object in Top View by clicking once on the object and then clicking once 
inside Top View where you want the object. 

Note: Objects that you can shape yourself behave differently. For details, see Draw your own 
object shapes.

4. When the object is in Top View, position it properly.
For details, see Position objects.



Search for objects
LandDesigner 3D lets you search for objects you can’t find immediately in the Object toolbar.

To locate an object you can’t find:

1. Click the Find button in the Object toolbar.

 
2. In the Search window that appears, click the Object Finder tab.
3. In the Object Finder tab, type the object of your search in the Type of Item field.

For example, type hammock or bench. You can also type part of a word. For example, you can type
sprink to find sprinkler objects.

4. Click Find # of Matches to see how many matches LandDesigner 3D found.
5. To add these matching objects to the Your Object toolbar menu in the Object toolbar, click 

Add to Object Bar and click OK.
6. Drag the item(s) LandDesigner 3D found from the Your Object toolbar menu into the 

Designer.
Note: The Your Object toolbar menu retains the items found in all searches until you exit 
LandDesigner 3D. If the menu becomes too congested, you can clear it by selecting Clear Your 
Object Bar from the Edit menu. 



Position objects
Use the Top View in the Designer to reposition and resize objects. You use the 3D View to see the 
effects of your work. Any changes you make in Top View will also appear in 3D View. 

What do you want to do?
Move objects 
Position decorations and smaller objects 
Place smaller items on larger objects 
Copy objects 
Delete an object 



Move objects

Elevation of dropped objects
Each object you drop into Top View is assigned a logical elevation, or height above ground. 
LandDesigner 3D places many objects on the ground, but there are exceptions. An outdoor place 
setting drops to a table, for example. You might want to revise an object’s elevation. For example, you 
can change the elevation of objects that sit on a slope. For details, see Position decorations and 
smaller objects.

Move objects with the mouse
To move an object to a new location in Top View, place your mouse pointer on it. When the “Move” 
handle appears, click and drag the object where you want it.

If necessary, use the Zoom tools to see the object better. To zoom in on the area that includes the 
object, click the + Zoom tool in the Top View toolbar, then drag in the Designer to define the 
rectangular area. The area is magnified when you release the mouse.

Move multiple objects
To move multiple objects at one time, you have two options:

· Choose the Drag Select option from the Edit menu and then click and drag in Top View over the 
items you want to move. After you define all the items, release the mouse. Next, click and drag the 
mouse on one of the objects you selected. All the selected objects will move.

 

· Hold down the Shift key and click on each object you want to move. When all the objects are 
selected, release the Shift key. Next, click and drag the mouse on one object. All the selected 
objects will move.

Move objects with the keyboard
By pressing the arrow keys on your keyboard, you can incrementally move selected objects up, down, 
left, or right. Repeat the commands as many times as necessary.



Position decorations and smaller objects
Once you finish adding the main objects in your design, you can add decorative elements such as 
flowerpots and outdoor lamps.

As a rule, don’t add decorations until after the major objects are in place and the right size. You can 
thus experiment freely without having to reposition every small object.

Decorative items are available from the Object toolbar, just like larger objects. When positioning 
smaller objects, you use many of the same tools as for larger ones.

If necessary, use the Zoom tools to see smaller objects better. See Using the Top View toolbar for 
instructions.

Note: If you need help selecting smaller objects when they are positioned below larger ones, right-
click on the larger object. Choose Select Object from the resulting menu and then select the smaller 
object’s name from the next pop-up menu.



Place smaller items on larger objects
If you position a smaller item in Top View on a larger object, the smaller item will “fall” nicely onto the 
object below. LandDesigner 3D uses this logic, for example, to place table settings on an outdoor 
table, or items on a deck.

However, if you then change the height of the table or deck, the height of the smaller items will not 
change. Your place settings, for example, might be sliced by the table. To fix this problem, change the 
Height Above Ground value of the smaller item. The Height Above Ground represents the bottom of 
the object.

To change an item’s Height Above Ground:

1. Open the item’s Spec Sheet by double-clicking on it.

2. Enter a new Height Above Ground value so the bottom of the object rests on top of the 
larger object.
For example, to make place settings appear to rest properly on a resized table, change the place 
settings’ Height Above Ground to equal the new height (not the Height Above Ground) of the table.

3. Click OK to close the Spec Sheet and see the results in the 3D window.
You might have to experiment with the Height Above Ground setting until the smaller item appears 
to rest on the larger one.

Note that LandDesigner 3D only drops and raises objects to surfaces that are large and wide 
enough to accommodate the smaller object. If necessary, resize one or both of the objects.



Copy objects
Once you have created and refined an object, you can copy it. Copies retain all dimensions, colors, 
and materials of the original.

To copy an object, select it and choose Copy from the Edit menu. Next, select Paste from the Edit 
menu to make the copy appear. Move the copied object in the design as needed.



Delete an object
If you decide that a certain object isn’t right for your landscape design, you can delete the object. You 
have the following options:

To delete a single object, click it and then press the Delete key. You can also select Delete from the 
Edit menu. 

To delete multiple objects, hold down the Shift key, click each object you want to delete, and then 
press the Delete key.

Note: If you make a mistake while resizing or repositioning an object, you don’t have to delete it and 
start over. You can undo the previous action by selecting Undo from the Edit menu.



Use an object's Spec Sheet
Spec Sheets give you many options for revising an object’s size, appearance, and other properties.

For information on revising plants in a spec sheet, see Revising a plant using its Spec Sheet.

Note: If you click the Mini View tab, a miniature version of the Spec Sheet appears in the Mini View on
the left side of the window. You can see the selected object’s name and revise the object’s width, 
height, and depth. You can also click the Change To button to replace the selected object with another
similar object. To open the more complete Spec Sheet from this miniature version, click Details. 

1. To open an object’s Spec Sheet, double-click the object.
You can also right-click the object and then select Specs from the menu that appears.

2. Set the object’s dimensions by entering values in the Width, Depth, and Height fields.
3. To return the object to its original dimensions, click the Original Size button. 

Some objects also have a list of suggested sizes in the Spec Sheet. If so, you can choose a size 
from the list.

4. If you are satisfied with the size and location of an object, you can lock its settings to make 
sure they aren’t changed accidentally.

To lock the object’s size, click the Lock Size box.

To lock the object’s size and location, click the Lock Size and Location box.

5. Click OK to close the Spec Sheet and return to the Designer.



Add colors and textures
Spec Sheets let you assign distinctive colors, textures, and styles to many objects in your design.

You can change these materials at any time in the design process. If you move objects after applying 
materials, the materials move with the objects.

To add materials to objects in the Designer:
1. Double-click in Top View on the object whose style you want to edit.

The object’s Spec Sheet opens. The Materials section displays panels for each style assigned to 
different parts of the object. For example, a park bench might have a panel for its legs and one for 
the bench.

If an object uses different materials within the same material category, two numbered panels appear
in the Materials section. 

For example, if a lawn chair uses one fabric for the back and another for its seat cushion, the 
materials are labeled fabric #1 and fabric #2.

2. To copy material shown in one panel of the Spec Sheet to another panel, click the first 
panel, drag the mouse over the panel you want to change, and release the mouse.

3. To change a material, click a panel.
The Choose Materials window opens for the selected style.

 
4. Use the following options in the Choose Materials window to find the style you want:

To view different material types, click one of the category buttons on the left side of the window. 

Once you select the category you want, scroll through the displayed panels to look at your choices. 
Place your mouse pointer on a material to see a quick description of it. To create your own material,
see Creating your own materials.

5. When you find a material you want, click its panel and click OK.
The Choose Materials window closes and the Spec Sheet reappears. The style you chose appears 
in the Materials area.

6. To assign the material permanently to the object, click the Lock Materials box.



7. Click OK to close the Spec Sheet and return to the Designer views.



Draw your own object shapes
LandDesigner 3D provides many predefined objects, but it also gives you the ability to create your own
shapes.    Your drawing options are determined by the type of object you need to create.

Shapes you define fall into two basic categories: closed shapes and lines.

What do you want to do?
Define closed shapes (e.g. driveways, decks) 
Define line shapes (e.g. fences, powerlines) 



Define closed shapes
Follow these steps to define your own closed shapes such as decks and driveways.

1. Select an appropriate object in the Object toolbar at the bottom of the screen.
If custom shapes are available, the Draw Type button at the right of the Object toolbar changes 
appearance when you select an object. Click this tool to see which shapes are available.

If you can’t define a shape for the selected object, the Draw Type button looks like the illustration 
below. Drag the predefined shape into Top View and resize it later.    See Reshape objects for 
more details.

2. With the object selected, click the Draw Type button to the right of the toolbar.
3. Select one of the following Draw Types from the menu and define the shape in Top View.

· Select the rectangular or circular shape and drag to define the size of the shape. When you 
finish, the object appears.

· Select the Point-to-Point Curve tool. 

Each time you click in Top View, you define one curve of a free-form, curved shape. Continue 
clicking until you define a closed shape. To end the shape, double-click on the last point or press 
the Esc, Enter, or Backspace key. The shape fills in.

· Select the Point-to-Point Line tool. 

Each time you click in Top View, you define a side of a free-form shape. Continue clicking until you 
define a closed shape. To end the shape, double-click on the last point or press the Esc, Enter, or 
Backspace key. The shape fills in.

To reshape these objects in Top View, see Define line shapes.



Define line shapes
Follow these steps to define line shapes such as fences and power lines.

1. Select an appropriate object in the Object toolbar at the bottom of the screen.
If line shapes are available, the Draw Type tool at the right of the Object toolbar changes 
appearance when you select an object.

2. With the line object selected, click the Draw Type button to the right of the toolbar.
3. Select one of the following Draw Types from the menu and define the shape in Top View.

· Select the Multi-Line tool.

 
· Move to Top View and define the line shape. Each time you click in Top View, you define a point 

on the shape. Continue clicking until you define a shape you like. To end the shape, double-click
on the last point or press the Esc, Enter, or Backspace key. The shape fills in. The object 
appears in Top View.

· Select the Line tool.

 
· Move to Top View. Click once to begin the line, then move the mouse to the endpoint and click 

again. The object appears in Top View.

· Select the Curved Line tool from the Draw Type menu.

 
· Move your mouse to Top View and define the shape. Each time you click in Top View, you 

define an arc of the shape. Continue clicking until you define a shape you like. To end the 
drawing, double-click on the last point or press the Esc, Enter, or Backspace key. The object 
appears in Top View.



Reshape objects
This section explains how to change the shape of objects once they’re in Top View. You can change 
the object’s size and rotate the object. If you define your own object shapes, you can reshape them by
using the “Pull” and “Stretch” handles.

What do you want to do?

For predefined objects:
Change an object  ’  s size   
Rotate objects 

For objects you shape:
Pull and stretch objects 
Edit points of objects 



Change an object's size
Sometimes objects look too big, or not big enough, for the design. In such cases you can easily 
change the object’s size.

To change an object’s size:

1. Click once on the object to select it in Top View. 
The small arrows that appear around the object let you resize it.

2. Hold the mouse pointer over an arrow, then click and drag the mouse to change the 
object’s size.

To increase the object’s width, height and depth, drag the mouse away from the object. To reduce 
the object’s width and depth, drag toward the center of the object. As you drag, the object’s current 
dimensions appear in Top View.

3. To change an object’s size using precise dimensions, double-click it and change the 
dimensions in the Spec Sheet.
For details on using the Spec Sheet, see Use an object  ’  s Spec Sheet  .



Rotate objects
If an object is in the right location but the angle is wrong, you can rotate it. 

To rotate an object:
1. Click once on the object to select it in Top View. 

The dot that appears beneath the object is the spin handle.

2. Hold the mouse pointer over the spin handle, then click and drag the mouse to rotate the 
object.



Pull and stretch objects
Objects you draw yourself have additional options for reshaping. When you select an object, you see a
set of outer handles and a set of inner handles, as shown in the illustration.

You can resize the entire object proportionally by clicking and dragging the mouse pointer over one of 
the outer arrows.

Use the inner handles to reshape objects.

To reposition one of the object’s points, hold the mouse pointer over one of the inner arrows 
around the object. When a “Stretch” handle appears, drag the point to a new location.

To reposition one of the object’s sides (or curves), hold the mouse pointer over one of the inner 
arrows around the object. When a “Pull” handle appears, drag the side to a new location.



Edit points of objects
Once you add your own object shapes in Top View, you can reshape them by right-clicking the “Pull” 
handles of particular points and using the resulting menu options.

Note: You only see this menu after right-clicking a Pull handle. The options are not available with 
Stretch handles or Move handles.

You have the following options for editing points:

Split (add a point). If you select Split, LandDesigner 3D adds a new point to the shape. You can then 
use the Pull handles and Stretch handles to reshape the object.

Join (remove a point). If you select Join, LandDesigner 3D removes the selected point and fills in the 
shape by redrawing the line between the two closest points.

Change curve/line. If you select this option, LandDesigner 3D changes the selected curve to a line.    
If you selected a line, it changes to a curve.

See also:

Pulling and stretching objects 



Digital collections
Additional objects for your designs are available at the Sierra Home Web site. Users can download 
these collections at no charge. If you have Netscape Navigator or Internet Explorer, you can connect 
to the Internet directly from LandDesigner 3D, as described below. If you are using a different Web 
browser, the steps may be slightly different.

Note: If you don’t find what you’re looking for in the product of in the digital collections, go to the 
message boards on our Web site and post a request for assistance.

To download new collections from our Web site:

1. Select Internet Features from the Features menu.
2. Click OK.

LandDesigner 3D takes you to your Internet connection prompt or browser. Log on to the Web as 
you usually do.

Note: If you don’t want to select a browser each time you use the Internet Features option, select a 
default browser using the Choose Web Browser option in the Features menu. 

3. At our Web site, select and download the collection(s) you want.
Complete instructions are available at the Web site.

4. To make the new objects appear in the Object toolbar of LandDesigner 3D, exit the program
and restart it.
Be sure to save any work before exiting LandDesigner 3D.

Note: The add-on plants for LandDesigner version 4.5 do not work with LandDesigner version 5.0.



Additional features
This section explains how to use the extra features included in LandDesigner 3D.

What do you want to do?

Record Walkthroughs and Snapshots 
Take a 3D photo 
Use the measuring tape 
Use the Shopping List 
Save your design 
Print your design 
Share your design 
Connect to the Web



Use the Shadow Caster
In Top View, the Shadow Caster feature simulates shadows in your landscape design based on time, 
date and location. Use the Shadow Caster to see how the sun affects your landscape over a day or a 
year. For more information, see Chapter 2 of the Design Guide, Using Sun and Shade.

Before using the Shadow Caster, adjust the compass in Top View. Compass changes affect shadow 
simulations. See Define the lot for instructions on using the compass.

To use the Shadow Caster:
1. Click the Design button in the Step-by-step toolbar and then click Dynamic F/X.
2. If necessary, move to Top View by clicking the Top View tab in the Top View toolbar.

The Shadow Caster is not available in 3D View.

3. Click the Mini View tab.
The Shadow Caster controls and Growth Over Time controls appear. For details on using the 
Growth Over Time feature, see Project Growth Over Time.

 
4. Set the date, time, and latitude you want to simulate.

You can enter these values directly or click the up and down arrows. When entering values directly, 
use the conventions and symbols shown in the fields.

For information about your city’s latitude, call your local branch of the United States Geological 
Surveyor. Find them on-line at www.usgs.gov. You can also go on-line at 
www.census.gov/cgi-bin/gazetteer where you can enter your location and get your latitude. 

5. Drag the Animate Shadows slider bar to determine how slowly or quickly the shadow effect 
occurs.

6. Click One Day or One Year to determine the period the shadow effect simulates.
LandDesigner 3D casts shadows over your design. Watch how the sun and shadow affect your 
landscape.



Project Growth Over Time
Use the Growth Over Time feature of LandDesigner 3D to see how the plants in your design will grow 
over various time periods. You can use these projections, for example, to determine how closely you 
should position adjacent plants.

You can observe Growth Over Time in the 3D View or Top View.

To use the Growth Over Time feature:
1. Click the Design button in the Step-by-step toolbar, and then click Dynamic F/X.
2. Click the Mini View tab.

The Shadow Caster controls and Growth Over Time controls appear. For details on using the 
Shadow Caster feature, see Use the Shadow Caster.

3. In the Years field, enter the number of years into the future you want to project plant 
growth.
You can enter this value directly or click the up and down arrows.

4. To project the plant’s growth over the number of years you specified, click Age Plants.
The plants increase in size accordingly.

 
Just planted



 
After 5 years

5. To reset the plants to their previous age and size, click Reset Age.
The plants will automatically revert to their original age when you switch to another view. To 
permanently change a plant’s age, use the Spec Sheet. For example, you can make an oak 10 
years older than younger plants in your design.

Note: The plants that grow over time include trees, shrubs, vines, cacti, ornamental grasses, 
ferns, perennials, and roses.



Project Seasonal Change
Use the Seasonal Change feature of LandDesigner 3D to see how the plants in your design look in 
various seasons. You can check seasonal changes in any design step by moving to the 3D view and 
then clicking the Mini View tab.

To use the Seasonal Change feature:
1. Move to the 3D View.

Click the 3D tab on the toolbar if necessary.

2. Click the Mini View tab.
3. Drag the Seasonal Change slider bar.

  

 

 



 



Record Walkthroughs and Snapshots
LandDesigner 3D lets you save your favorite views and Walkthrough tours in each design. You can 
then view these Snapshots and animated tours at any time. Walkthroughs and Snapshots let you 
quickly communicate your ideas with landscape contractors and designers.

What do you want to do?
Take Snapshots 
View Snapshots 
Record a Walkthrough 
Play back a Walkthrough 



Take Snapshots
A Snapshot is a recorded image of a favorite 3D view in your landscape design; they work somewhat 
like bookmarks. Snapshots are a good way to save a list of sites in your design for quick review.

To record a Snapshot:
1. Select Record Video & Snapshots from the Features menu.

The Recorder Options window appears.

2. Click the Snapshots tab.
3. Use the 3D view controls to show the area you want to record in the Snapshot.
4. Click the Record button to store the Snapshot.
5. Type the name for your Snapshot in the Name field.

If you don’t want to name the Snapshot, you can use the generic name LandDesigner 3D assigns 
automatically.

You can view the Snapshot at any time.

6. Click Close to exit the Recorder Options window.
You can now view the Snapshot in LandDesigner 3D whenever the saved design file is open.



View Snapshots

1. Select Record Video & Snapshots from the Features menu.
2. Click the Snapshots tab and then select the Snapshot you want to view from the list.
3. Click Play to view the selected Snapshot.

To delete a Snapshot, select it in the list and click Delete.

4. Click Close to exit the Recorder Options window.



Record a Walkthrough
A recorded Walkthrough is an animated, 3D tour of your design in LandDesigner 3D.

To record a Walkthrough:
1. Position the camera in Top View where you want to begin your Walkthrough. 

You can further adjust this beginning view by switching to 3D View and using the navigation arrows 
in the Object toolbar. 

2. Select Record Video & Snapshots from the Features menu.
The Recorder Options window appears.

3. Click Record to begin recording the Walkthrough.
4. Navigate through your 3D scene along the path you want to record.

The Walkthrough feature stores all of your movements as well as their speed.
5. Click Stop to end the Walkthrough recording.

The Stop button only works while you are recording.
6. Type a name for your Walkthrough in the Name field.

If you don’t want to name the Walkthrough, you can use the generic name LandDesigner 3D 
assigns automatically.

7. To save the recorded Walkthrough as an .avi video file, click the Save button.
LandDesigner 3D warns you that the file might be large and might take a long time to create. If you 
want to proceed, click Yes. When the file is complete, LandDesigner 3D prompts you to assign the 
file a name and directory path. 

The file is saved in .avi format, and can be opened and played outside LandDesigner 3D in a 
Windows video program.

8. Click Close to exit the Recorder Options window.
You can now play back the animated Walkthrough in LandDesigner 3D whenever the saved design 
file is open. 



Play back a Walkthrough

1. Select Record Video & Snapshots from the Features menu.
2. Click the Walkthroughs tab and then select the Walkthrough you want to view from the list.
3. Click Play to view the selected Walkthrough.
4. While the Walkthrough is playing, you can click Pause to pause the playback.

If you click Pause, you can click Resume to continue.
To delete a Walkthrough, select it in the list and click Delete.

5. Click Close to exit the Recorder Options window.



Change backgrounds and ground covers
If you don’t like the default background image and ground cover 3D Sierra Landscape uses in your 
landscape designs, you can change them. 

Note: The default ground cover applies to your entire design. It is different from ground covers you add
from the Object toolbar, which apply only to particular planted areas.

To change your default background and ground cover:

1. Select Options from the Features menu.
2. Click the 3D View tab.
3. To choose a different background for your design, click the Change Location button.

When you select a background, click OK to return to the 3D View options.
4. To choose a new, default ground cover for your design, click the Change Ground button. 
5. Use the Choose Materials window to find the ground cover you want.

To view different material types, click the material buttons on the left side of the window.

Once you select a category, scroll through the displayed panels to look at your choices. Place 
your mouse pointer on a panel for a quick description of it.

6. When you find a ground cover you want, click its panel and click OK.
The Choose Materials window closes and the 3D View options appear.

7. Click OK to close the 3D View options and see the new ground cover and background in the
Designer.
The background and ground cover are applied to the entire design. Later you can add more ground 
covers to particular planted areas from the Object toolbar.



Import your own background
You can prepare your own background images for landscape designs in the graphics program of your 
choice. You can also copy images from other applications or Web sites. Use the following guidelines to
create the image:

· Correct for accidental tilting and aspect ratio and adjust brightness and contrast as needed.

· Size your image to a height of less than 480 pixels. Images with greater heights will appear 
centered in LandDesigner 3D, with the top and bottom truncated. The image can have any width, 
including panoramic dimensions of more than 1,000 pixels.

· Save the background image as a Windows Bitmap file (.bmp). LandDesigner 3D can import 256-
color (8-bit) and million-color (24-bit) .bmp files.

You’re ready to import the image as your design background.

To import your own background into LandDesigner 3D:

1. Select Options from the Features menu.
2. Click the 3D View tab.
3. Select Change Location.
2. Click on the Choose My Own button.
3. In the next window, enter the directory path for the background image if you know it.

If you don’t know the path, click Browse. The Open window appears. Use the window to locate and
select the background bitmap file. See your Windows manuals if you need more information for 
using this window.

4. Click OK to close the window and see the background.



Use the measuring tape
The Measure tool in the Top View toolbar lets you measure the distance between any two points in Top
View. Click the Measure tool, then click two points in the Designer — one where you want the 
measurement to begin, and the other where you want it to end.

You have the following options for revising a measurement:

To move a measurement in Top View, click and drag it anywhere between its endpoints.

To resize or rotate a measurement, first click it to display its endpoints, then click and drag either 
endpoint.

To delete a measurement, select it and press the Delete key.

Other measurement tools
In addition to the Measure tool, LandDesigner 3D has other features that help you measure aspects of 
your design:

Dimensions in Top View. The Top View displays a plant or object’s width and depth as you resize it. 
To resize a plant or object, click it to select it, then drag one of the arrows around it. 

Standard versus metric units. By default, LandDesigner 3D uses standard (U.S.) units to display 
dimensions. To switch to metric units, select Options from the Features menu, click the Top View tab,
and click Display Metric Units. To switch back to standard units, repeat the previous steps.

Grid in Top View. To help you align objects and assess spatial relationships in Top View, you can 
display a grid over it. To turn on the grid, select Options from the Features menu, click the Top View 
tab, and click Display Grid. You can also change the grid spacing, if necessary.



Use the Shopping List
Use the Shopping List to get a rough idea of how much your design might cost to build from scratch. 
The Shopping List also helps you keep track of selected design elements, as well as their quantities, 
unit prices, and subtotals.

1. To see the Shopping List, select the Finish phase in the Step-by-step toolbar and then click 
Shopping List.
The Shopping List window appears. Each major category of design elements is shown as a button 
on the left side of the list. 

2. Click a category button to see a breakdown of costs within the category.
Click the button again to hide the details. When details are hidden, the category button appears with
a (+) sign.

Related topics:

View all the objects in the list 
Modify prices 
Adjust column widths 
Export a Shopping List 
Print a Shopping List 



View all objects in the list
Most plants and objects you add to a design appear in the Shopping List. If you select Options from 
the Features menu and then click Show All on the Price tab, all items will appear on the Shopping 
List.



Modify prices
To modify the price of a particular plant or object, double-click it in the Top View to see its Spec 
Sheet. Click the Price tab and revise the price. Note that not all objects have prices.



Adjust column widths
The Shopping List has columns for a plant or object’s name, size, quantity, unit price, subtotal, and 
notes. To adjust the width of a column, move the mouse over the side of a column heading until the 
cursor changes to a . You can then click and drag the mouse to resize the column.



Export a Shopping List
If you want to crunch the numbers for the estimated costs of a design, you can export the Shopping 
List to a spreadsheet application such as Microsoft Excel. You can also export the list to text editors 
such as Microsoft Notepad.

To export the Shopping List:
1. Click the Export button in the Shopping List window.
2. In the window that appears, enter a name for the shopping list in the File Name field.
3. If necessary, save the file to another directory on your drive.

By default, the file is saved to the C:\Sierra\LandDesigner 3D directory.

4. Click Save to export the Shopping List to its own file.
5. Open the Shopping List file in another program such as Excel or Notepad.



Print a Shopping List
If you print your Shopping List, use the landscape orientation. You can choose this setting by selecting 
Print Setup from the File menu. If you need help, see Print the design.



Set display and sound options
For a comprehensive list of these display options and a brief description of each, see Options dialog 
box.

What options do you want to set?

Layers 
Sound options 



Layers
Aside from the display controls in the Options dialog box, you can also change the Top View by 
displaying or hiding the following items in the Visible Layers list. For more details, see Use layers.

Foliage. When selected, plants are shown with full foliage. If you turn this option off, plants appear as 
circles.

Slope Detail. When selected, the ground displays any mound or holes you applied.

Utilities. When selected, the locations of all utilities such as property lines and water lines are shown 
in Top View.

Sprinkler Coverage. When selected, sprinklers appear with their coverage areas. If you turn this 
option off in Top View, the sprinklers appear alone.

Plant Labels. When selected, plant labels appear with their items in Top View. This option is off by 
default.

Your Notes. When selected, any notes you added to Top View are shown with the design.



Sound options
You have two options for controlling sound in the Options dialog box. To change these settings, select 
Options from the Features menu and then click the Sound tab.

Program Sounds. Select this option to turn the LandDesigner 3D sound effects on and off. By default 
the sound is on. 

This option, like many in the Options dialog box, is a simple toggle, which means it works like an on-off
switch. If your computer does not have a sound card and speakers, you will not hear the sound effects.

Walkthrough Sound. Use this list to select which sound effect you hear when navigating 3D View. By 
default, you hear footsteps. To hear an example of a new sound effect, select it in the list and click 
Audition. To choose a new sound for Walkthroughs, select it in the list and click OK.



Connect to the Web
You can connect to the World Wide Web directly from LandDesigner 3D. For example, you can go to 
Sierra’s Web site and download additional objects for your designs. For more details, see Digital 
collections.

To go to the World Wide Web from LandDesigner 3D:

1. Click the Internet Features button at the top of the main window or select Internet Features 
from the Features menu.

2. In the window that appears, select the Internet browser you want to use.
If a browser option is dimmed, you do not have the browser on your hard drive. To select another 
browser, click Other and then click Browse. In the resulting file dialog box, locate and select the 
browser you want to use.

3. Click OK.
Note: If you don’t want to select a browser each time you use the Internet Features option, select a 
default browser using the Choose Web Browser option in the Features menu. 

LandDesigner 3D takes you to your Internet connection prompt or browser. Log on to the Web as 
you normally do.

You can also log on to the Internet through the Info tab of some Spec Sheets. See Spec Sheets for
details. 

For information on sending your design as an attachment to e-mail messages, see E-mail your 
design.



Use Internet Walkthrough and Design Sharing
You can use this feature to show another user your designs over an IP (Internet Protocol) network.    
Note that both you and the sender/recipient of the design need to be connected to an IP network and 
have LandDesigner 3D running on your computers.    When connected, the sender's LandDesigner 3D 
display appears on the recipient's screen.    You can even play a saved Walkthrough for the recipient. 

To send your design to another machine:
1. Open “Internet Walkthrough & Design Sharing” from the Features menu.

2. Select “Send a Design” from the “Prepare for Design Sharing” dialog box.
3. Type in the IP network number of the recipient.

This number appears in the recipient’s “Receive a Design” dialog box.    This connects you to the 
recipient’s machine. Now your display will appear on the second machine.    You can take the 
recipient on a Walkthrough of your design by navigating in 3D View.    Type notes to each other in 
the Edit Field inside the Design Sharing dialog box.

The recipient is not able to navigate within your design. He or she is only an observer. To allow the 
recipient to drive, click on "Let the other person drive."    Now your roles reverse: the second user 
drives, and you observe.    The second user has to click "Let the other person drive" to enable you to
drive again. 

To receive a design from another machine:

1. Open “Internet Walkthrough & Design Sharing” from the Features menu.

2. Click "Receive a Design" in the "Prepare for Design Sharing" dialog box.
Your IP address will be displayed. Give this number to the sender so he or she can enter it. Once 
the sender installs your address, his or her design will appear on your screen. 



Quick reference
After you become familiar with LandDesigner 3D, use this Quick Reference section for explanations of 
each menu option, descriptions of the toolbars, and instructions for using the Spec Sheets.

What do you want to look up?

Menu reference    
Toolbar reference    
Spec Sheets 
Improve performance 
Solve memory problems 
Set display and sound options 
Terms in the Glossary 



Menu reference
File menu. Use this menu to control the design files you create in LandDesigner 3D. You can also use 
these options to print designs, e-mail them, and export them as bitmap graphics.

Edit menu. Use these options to select, copy, delete, and lock objects.

Features menu. These menu options let you connect to the Internet, set display options, and record 
Walkthroughs and Snapshots.    For information on the Options dialog, see Options menu.

Custom menu. These options allow you to customize LandDesigner 3D.    You can create your own 
objects and textures.

Design Guide menu. Use these options to get tips and information for designing your landscape.

Windows menu. These options let you control the display of windows in LandDesigner 3D.

Help menu. Choose an option to use the online help.

Click a menu to see its options. You can also open a menu by holding down the Alt key and pressing 
the key that matches the underlined letter in the menu name. For example, you can open the File 
menu by pressing Alt and F.



File menu
Use this menu to control the design files you create in LandDesigner 3D. You can also use these 
options to print designs, e-mail them, and export them as bitmap graphics.

New Opens a new Designer screen in LandDesigner 3D, where you can create a new 
design.

Open Opens an existing LandDesigner 3D file.

Open Sample Opens a LandDesigner 3D sample design. See View sample designs for 
instructions.

Save Saves your current open file. See Save your design for instructions.

Save As Allows you to change the name of an existing file.

Save as Sample 
File Saves your design as a sample landscape, so you can use it again to develop other 

designs. You'll find these samples in the Open Sample dialog under “My Samples.” 
See Save your design for instructions.

Mail this Design Allows you to e-mail your design. If you do not have an e-mail package, you should 
not use this command, otherwise it may crash your system. See E-mail your design
for instructions.

Export Bitmap Saves your current 3D View as a two-dimensional bitmap image, which you can later 
open in a graphics program. This option is not available until you select the 3D View. 
See Export a design for instructions.

Print Prints the contents of either Top View or 3D View, depending on which window is 
active. For details on printing, see Print your design.

Print Preview Displays a window that lets you preview what the printed design will look like.

Print Setup Use Print Setup to specify a printer, paper orientation, and type of paper used. Click 
the Options or Properties button to select advanced printing settings. Press F1 in 
Print Setup for online help.

Exit Exits LandDesigner 3D.

Note: The names of recently opened design files appear in the File menu just above the Exit option. 
Click the file name to open the file.



Edit menu
Use options in the Edit menu to select, copy, delete, and lock objects in LandDesigner 3D.

Undo Cancels your last action in the Designer. 

Cut Removes the selected item and puts it on the clipboard. You can then paste the item 
elsewhere. This command is unavailable if no item is selected. Cutting items to the 
clipboard replaces the contents previously stored there.

Copy Copies the selected item onto the clipboard. You can then paste the item elsewhere. 
This command is unavailable if no item is selected. Copying an item to the clipboard 
replaces the contents previously stored there.

Paste Inserts a copy of the clipboard contents into your design. This command is 
unavailable if the clipboard is empty.

Delete Deletes the selected object in Top View.

Select All Selects all objects in Top View.

Select None Deselects all currently selected objects in Top View.

Drag Select Selects multiple plants and objects in Top View. After selecting this option, click and 
drag your mouse over the appropriate plants and objects in Top View.

Group Binds multiple items together as a single grouped object.

Ungroup Turns a set of grouped items into independent entities again.

Lock Selected 
in Place Locks a selected object in place to prevent it from being moved accidentally. When 

the selected object is locked, this menu option changes to Unlock Selected. If you 
select this option again, the object becomes unlocked. 

Clear Your 
Object Bar The Your Object Bar menu retains the items found in all searches until you exit 

LandDesigner 3D. If the menu becomes too congested, you can clear it by selecting 
this option.



Features menu

Interview Opens the Interview wizard. Through questions the program becomes customized for
your zone, climate, soil type and common or Latin name preferences. See Start your
design for instructions. 

Shopping List The Shopping List records and tracks selected design elements, as well as their 
quantities, installed prices, unit prices, and subtotals. See Use the Shopping List for
instructions. 

2D & 3D 
Designer Opens the Designer, the main screen you use to complete your landscape design in 

LandDesigner 3D. The Designer has a Top View, which is an aerial floor plan you use
to add plants and other objects, and a 3D View, which provides a realistic view of 
your design. See Navigate the Designer for instructions. 

Plant & 
Object Finder Opens the Finder where you can locate specific plants and objects and add them to 

Your Object Bar. See Find objects or Find plants for instructions. 

Record Video 
& Snapshots Opens the Recorder Control window. Use this feature to record a Walkthrough or 

Snapshot in 3D View. See Record Walkthroughs and Snapshots for instructions. 

Take Photo Record a high quality image of your design. See Take a 3D photo for instructions.

Lot Wizard The Lot Wizard takes you through the following 3 steps to define your lot: setting 
dimensions, laying down the property lines, and setting the compass. See Define the
lot for instructions. 

House Wizard The House Wizard helps you quickly build a facsimile of your home in the landscape 
design. See Define your house for instructions. 

Slope Wizard The Slope Wizard lets you create slopes and grades on your lot. See Define the 
slope of your lot for instructions. 

Irrigation 
Wizard Takes you to the Irrigation Wizard, where you can plan an irrigation system for your 

design. See Irrigation basics for more information. 

Garden Bed 
Wizard Takes you to the Garden Bed Wizard, where you can quickly lay out an entire bed of 

plants. See Add garden beds and hedges for instructions. 

Shadow Caster Opens the Shadow Caster window, where you can see how shadows fall across your
design in Top View. See Use the Shadow Caster for instructions. 

Growth Over 
Time Lets you to see how the plants in your design will mature over time. See Project 

Growth Over Time for instructions.

Seasonal 
Change Lets you see how the plants in your design change according to season. See    

Project Seasonal Change for instructions.

Design Review The Design Review will look for possible design problems, from irrigation or wall 
measurement to tree locations and much more. See Review your design for more 
details.

Internet 
Features Opens your Web browser so you can connect to the Internet. See Connect to the 

Web for instructions.



Choose Web 
Browser If you have more than one Web browser available, lets you select a Web browser to 

use. See Connect to the Web for instructions.

Internet 
Walkthrough 
& Design 
Sharing Lets you share your designs with another LandDesigner 3D user over the Internet.    

See Use Internet Walkthrough and Design Sharing for instructions.

3D Options Rendering requires a tradeoff between viewing quality and the speed with which the
3D image is created. During the basic design phase of your landscape, you might 
want to increase the rendering speed at the expense of image quality. You can then 
navigate through the 3D View more quickly, which will require less time to generate 
the 3D scene.

Options See Options dialog for complete information.



Options dialog box
Use the controls in the Options dialog box to enable or disable sound, to control how objects snap 
together, and to control various display settings. 

The Options dialog box is divided into five sections, or tabs.

3D View tab 
Top View tab 
LandDesigner tab 
Sound tab 
Price tab 
Design Review tab 



3D View tab
Set Lights Increase the number of lights to brighten the 3D View. Decrease the number of lights 

to make the 3D View darker. 

Choose Quality
of Scene Select one of the options to set the display quality of the 3D View. For details, see 

Improve 3D View speed.

Change Ground Click this button to change the default ground cover of your landscape design. See 
Change backgrounds and ground covers for instructions.

Change 
Location Click this button to change the background setting of your landscape. See Change 

backgrounds and ground covers for instructions.

When I am 
not doing 
anything else Click this box if you want to postpone rendering a photograph of your design to when 

your machine is idle.

Stop me from 
walking 
through walls Click to choose your preference for the program’s behavior when walking around in 

3D View

When I render 
a photo… There are two options. You may choose to use the depth-of-field blur, which is a 

camera-like feature. The other option allows you to change the time-of-day shading 
when rendering a high-resolution graphic.



Top View tab
Display Grid If you check this box, LandDesigner 3D displays a grid in Top View to help you align 

objects.

Display Metric 
Units Allows you to switch between displaying dimensions in standard American units or 

metric units. Check the box to display metric units.

Hide Area Fills This feature is especially useful when printing. This creates an outline of all the items 
in your design.

Set 2D Grid 
Spacing If you display a grid in Top View, you can vary the grid spacing with this control. Click 

Default to return to the original spacing (2 feet).



Sound tab
Program 
Sounds When you select this check box, all sounds play in LandDesigner 3D. When 

deselected, sounds are turned off. See Sound options for details.

Walkthrough 
Sound Lets you specify the sound you hear as you navigate the 3D View. By default, you 

hear footsteps. To hear a sample sound, click Audition. See Sound options for 
details.



Price tab
Show All on 
Shopping List By default, most architectural elements are shown with their prices on the Shopping 

List. Check this feature to see all items in your design on the Shopping List.



LandDesigner tab
Growth Rate Drag the slider bar to indicate how quickly plants typically grow in your area. See 

Project Growth Over Time for details.

Hide plant photo
This refers to the plant image insets in the Object toolbar.    When turned off the 
program may run faster.    

Load recent
design The default is to open the latest design you have created at start up. Turn it off if you 

frequently open different files.    



Design Review tab
Click each of the functions listed below that you would like to be included in a Design Review.    By 
default, all functions are selected.    Access Design Review through Design Review in the Features 
menu.

ü Check to see if trees are too close to your house

ü Check to see if plants are shaded by other plants

ü Check to see if evergreens are blocking the sun on the south side of lot

ü Check to see if the driveway is too narrow

ü Check to see if the path is too narrow

ü Check for existence of irrigation systems

ü Check to see if your plants can survive in the specified zone

ü Check to see if plants are too close to each other

ü Check to see if there are generics

ü Check to see if deck is too close to lot line

ü Check to see if deck has railing

ü Check to see if garden shed is too close to the lot

ü Check for size of lawn

ü Check to see if walls are higher than 3 feet

ü Additional advice



Windows menu
The Windows menu has the following options:

Zoom In Allows you to view your design from a closer vantage point.

Zoom Out Allows you to view your design from farther away.

Zoom to 
Lot Size Resizes Top View to display all objects.



Design Guide menu
Use the commands in this menu to get tips and information for designing your landscape.

Contents View the contents of the Design Guide. Click a topic for information.

Last Topic View the last topic you read in the Design Guide.

Search Search for a particular topic of interest in the Design Guide.

Chapters Go to particular chapters of the Design Guide.



Help menu
Use the commands in this menu to get tips and information for using LandDesigner 3D.

Contents View the contents of the online help. Click a topic for information.

Guided Tour View a series of narrated, animated tutorials that help you understand LandDesigner 
3D.

AutoPlay 
Guided Tour If you want LandDesigner 3D to play the Guided Tour each time you enter a new 

design step or new window, leave this option selected. When selected, the option 
appears with a check mark.

Credits See the list of people who developed LandDesigner 3D.

About View information about the product.

Version See the version number of the LandDesigner 3D software.



Toolbar reference
LandDesigner 3D’s Designer includes three toolbars:

· The Top View toolbar, which helps you control the Designer display.

· The Top View tools in the Object toolbar.

· The 3D View tools in the Object toolbar.

The Object toolbar of the Designer changes according to which view you’re using. To work in the 3D 
View or the Top View, click the Top View tab or the 3D tab in the Top View toolbar.

What do you want to look up?

Top View toolbar 
Top View tools in the Object toolbar 
Navigation arrows 



Top View toolbar
The Top View toolbar helps you control the Designer display. The toolbar contains the following 
options. To see all these options, you must be in Top View.

 
3D. Click this tab to change the Designer to 3D View.
Top. Click this tab to change the Designer to Top View.
Zoom. To zoom in on a particular area of the design, click the + Zoom tool in the Top View toolbar, then 
drag in the Designer to define the rectangular area. The area is magnified when you release the mouse. 
Click the - Zoom button to zoom out from a magnified, enlarged view.

Note:    To resize Top View to display your entire lot, choose Zoom to Lot Size from the Windows 
menu.

Visible Layers. Click this button to view a list that lets you turn the display of foliage, utilities, and 
other details on or off. For more information on using this feature, see Use layers.

Add Text. Use this tool to add notes or descriptions in Top View. Click the Add Text button in the Top 
View toolbar.    Next, click where in the design you want to add the note.    A dialog box will appear.    
Type the note, choose whether you want the note to include an arrow, then click OK.    Double-click 
the label box to edit the note.    If you added an arrow, drag the arrowhead to where you want it to 
point.    To move the note, click and drag it to a new location.

Measure. The Measure tool lets you measure the distance between any two points in the Top View. 
For details on using the Measure tool, see Use the measuring tape.

Drag Select. Use this tool to select multiple plants and objects in Top View. Click the tool, then drag 
your mouse over the appropriate plants and objects in Top View. Once you’ve selected the items, you 
can move, delete, or manipulate all the items at once.



Top View tools in the Object toolbar
Use the Object toolbar at the bottom of the screen to add plants and other objects to your design. To 
see this toolbar, click the Top View tab in the Top View toolbar.

 
To use the Object toolbar in Top View:

1. Click the menus for the type of plant or object you want to add.
These menus appear at the left side of the toolbar. When you click a menu, a list of plant or object 
categories appears. Choose the category you want.

A group of related items appears to the right of the menus. Note that the menus are hierarchical. In 
other words, your choice in a menu determines the options that appear in the lower menus. 

A brief description of the item usually appears when you hold your cursor over it in the Object 
toolbar.

2. When you find the item you want to include, click its icon and drag it into Top View. 
3. Look through all the categories to get familiar with the organization. If you don't see what 

you want, search for your plant or object by clicking the Find button.
For details on using the Find button, see Use the Plant Finder.



Navigation arrows
Use this toolbar at the bottom of the screen to control the 3D View and move around in it. To see the 
toolbar, click the 3D tab in the Top View toolbar.

 
The navigation arrows give you the following options:
View. Click the two View icons to switch between an overhead view (helicopter icon) or an eye-level view.
Move. Click a Move arrow to move in the direction indicated by the arrow. Hold down the mouse to 
continue the movement.
Height. To adjust viewing height, click the up and down arrows. 

Tilt. Click the Tilt icons to adjust your viewing angle.

Note: The tools listed above are also available when the 3D View is selected in the Mini View.



Spec Sheets
LandDesigner 3D allows you to assign dimensions, colors, and textures to selected plants and objects 
using Spec Sheets. When you double-click on an object, its Spec Sheet opens, revealing properties 
of the item that you can change.

What do you want to do?

Use Mini View Spec Sheets 
Use Spec Sheets 



Use Mini View Spec Sheets
If you click the Mini View tab, a miniature version of the Spec Sheet appears in the Mini View on the 
left side of the window. You can see the plant or object’s name and revise its width, height, depth, or 
length. To open the Spec Sheet from this miniature version, click Details. 

You will notice slightly different options in Mini spec sheets for objects, plants, sprinklers, and house 
blocks. For example, the Mini spec sheet in the following illustration has a Change To option that lets 
you replace the selected object with another similar object.



Use Spec Sheets
Use Spec Sheets to edit properties of an individual furnishing or object, including size, materials, color,
style, and price. 

To open an object's Spec Sheet, double-click the object. You can also select it and click the 
Details button in the Mini View.

Most Spec Sheets are divided into at least five categories of information, called tabs: 

Basics tab. Includes dimensions and materials.

Preview tab. Displays the selected object from all angles in 3D. This tab is not available for plants.

Personal Notes tab. Lets you enter notes about an object.

Info tab. Provides access to more information on the object.

Price tab. Provides pricing information.



Basics tab
The Basics tab displays the plant or object’s name, current dimensions, and other properties. Edit 
these settings to revise the selected plant or object.

Replace With. This control works differently for objects and plants. To replace an object with 
something similar, click the Replace With button. A series of related objects appears. For example, 
you may have first placed a hammock in Top View, but you might want to change to a bench. Scroll 
through the Replace With window, click on the new object you want, and click OK to make the change 
and return to the Spec Sheet.

If you are working in a plant’s Spec Sheet and you click the Replace With button, the Plant Finder 
appears. For details on this feature, see Use the Plant Finder.

Size and Location. These controls are the best way to precisely control the size and elevation of 
plants or objects. You can change the plant or object’s Width, Depth, Height, and Height Above 
Ground by entering new dimensions in these fields. 

Original Size. To return to the plant or object’s original size, click the Original Size box. 

Suggested Sizes. Some plants or objects come with a set of suggested sizes, which you can select 
from the Spec Sheet.

Lock Size. Once you decide on your plant or object’s dimensions, check Lock Size. When locked, a 
plant or object cannot be accidentally resized in Top View, and you cannot edit the Width, Depth, and 
Height settings.

Lock Size and Location. Check this box if you want the plant or object’s size and position to remain 
the same. When the plant or object’s size and location are locked, you cannot edit the other settings 
under Size and Location.

Materials. The panels in the Materials section represent all the colors and textures you can change for
the selected object. An object can have one or more panels. Each panel shows a picture of the 
material and the name of the region where the material is applied. For a quick description of a 
material, hold the mouse pointer over a panel.

Note: Plants do not have material options in their Spec Sheets.

To change a material, click on its panel. The Choose Materials window opens. You can choose from 
hundreds of materials for the selected object. For details, see Add colors and textures. After you 
choose a new material, click OK to return to the Basics tab of the Spec Sheet. The panel will show 
your change.

To copy the material shown in one panel of the Spec Sheet to another panel, simply click the 
first panel, drag the mouse over the panel you want to change, and release the mouse. 

Lock Materials. When you are satisfied with the chosen materials, you can check this box to prevent 
the materials from being changed by settings you make later in the Spec Sheet. Click again on the box
to cancel the lock.

Additional Options for Plants. Some plants have additional options that appear on the right side of 
the Spec Sheet. For example, you can assign a plant a different flower color. To display the plant by its
size at a certain age, enter an age and then click Size Based on Age. The plant’s height and width will 
change, but the amount of its branches and foliage will not.



For details on using the Change Custom Info option, see Add your own plant records.

For general information on using Spec Sheets, see:

Revising a plant using its Spec Sheet 
Use an object's Spec Sheet 



Preview tab
Click the Preview tab to preview the selected object from all angles in 3D before leaving the Spec 
Sheet. You can drag your mouse across the object to rotate it, click the Spin check box to rotate it 
automatically, or click the Top button to look down at the object.

Note: The Preview tab is not available for plants, and is not available for all objects.



Personal Notes tab
Use this tab to enter your own comments about the object. These comments will be saved with your 
design. If you want to clear the notes and start again, click Clear Notes.



Price tab
LandDesigner 3D provides Low, Medium, and High prices for many objects, based on installed, retail 
prices. Choose one of these prices or click the Yours option and type a price of your own.

Even if the object has not been assigned a price, you can assign one yourself.

Add to the Shopping List. If you check this box, the price you select or enter in the Price tab appears
in the Shopping List of LandDesigner 3D. For details, see Use the Shopping List.



Improve performance
You might find the following tips helpful when using LandDesigner 3D:

Hardware acceleration 
Improve 3D View speed 
Turn off layers 
Recommended Video Display 
Sound 



Improve 3D View speed
Rendering refers to the way LandDesigner 3D creates a three-dimensional effect on a 2D screen. 
Rendering requires a tradeoff between viewing quality and the speed with which LandDesigner 3D 
creates the 3D image.

During the basic design phase of your landscape, you might want to increase the rendering speed at 
the expense of image quality. You can then navigate through the 3D View more quickly, since 
LandDesigner 3D will require less time to generate the 3D scene.

Later, when you want to see all the materials and colors you’ve assigned, you can switch back to a 
better image quality and longer rendering time.

To control rendering speed and image quality:

1. Select Options from the Features menu.
2. Click the 3D View tab in the Options dialog box.
3. To change the rendering method, click one of the following Quality of Scene options:

Full light, all materials. Select this setting to see the highest-quality image, but at the slowest 
rendering speed. This setting is good for viewing your finished design.

Minimal light, all materials. This intermediate setting is a compromise between rendering speed 
and image quality.

Full light, no materials. Select this setting to increase the rendering speed but decrease 3D image
quality.

Note: You can also increase rendering speed by clicking the Draft Mode check box, which appears
in the Mini View when you select the Design phase in the Step-by-step toolbar and then select 
Dynamic F/X.



Turn off layers
You might notice a decline in your computer’s performance as your design becomes more complex. 
The Visible Layers button in the Top View toolbar lets you turn off the display of many items in your 
design. For example, you might improve processing speed by turning off the display of plant foliage.

For more details on the Visible Layers options, see Use layers.



Solve memory problems
Because of LandDesigner 3D’s rendering capabilities and other advanced features, the program might
require more memory than some computers can provide. If your processor runs short of memory, you 
may notice these symptoms:

· Parts of LandDesigner 3D do not start or display.

· The display shows an inappropriate color scheme.

· Printouts appear as if created on a typewriter.

· LandDesigner 3D stops responding to keyboard or mouse commands.

If you encounter such difficulties, try the following techniques to help you overcome memory shortfalls:

· Close other applications while running LandDesigner 3D. Note that some programs may start 
automatically when you start Windows. You’ll find these program icons in your Windows Startup 
group.

· Reboot your computer.

· Increase the amount of random access memory (RAM) in your system. 



Glossary
Use the glossary for quick explanations of important terms in LandDesigner 3D. 

Camera
The camera controls your view in 3D. The camera tool is the red icon that appears in Top View. Point 
the camera toward an area you want to see in 3D View. For details, see Move the camera.

Designer
The main screen you use to complete your landscape design in LandDesigner 3D. The Designer has a
Top View, which is an aerial floor plan you use to add plants and other objects, and a 3D View, which 
provides a realistic view of your design.

Dragging
Dragging refers to holding down the mouse button while you move the mouse pointer across the 
screen.

Finder
The Finder gives you access to LandDesigner 3D’s extensive database. Use this feature to locate 
plants and objects or to replace generic “placeholder” plants.

Object toolbar
These controls at the bottom of the Designer display objects and plants in Top View, and navigational 
tools in 3D View.

Panels
Panels are the squares shown in the Materials section of object Spec Sheets. Panels show a small 
picture of the material assigned to an object. Hold your mouse over a panel to see a quick description 
of the material. Plants do not have materials in their Spec Sheets.

Rendering
Rendering refers to the way LandDesigner 3D creates a three-dimensional effect on a 2D screen. 

Rotating
Each selected plant or object has a spin handle. To rotate a plant or object in Top View, click its spin 
handle and drag it in the direction you want to rotate it.

Shopping List
A feature in LandDesigner 3D that keeps track of selected design elements, as well as their quantities, 
installed prices, unit prices, and subtotals. For details, see Use the Shopping List.

Spec Sheets
Spec Sheets are windows for editing properties of a selected plant or object, including its size, 
assigned materials, color, style, and price. To view the Spec Sheet of a plant or object, double-click it.

3D View
3D View is a realistic representation of your landscape design. The red camera in the Top View 
controls what you see in 3D. You can navigate the 3D View using the mouse, the arrow keys on your 
keyboard, or the navigational arrows at the bottom of the screen. 



Top View
The window in LandDesigner 3D where you add, arrange, and revise plants and other objects. The 
Top View displays your design from an aerial perspective.

Wizard
A series of windows that helps you build a component of your landscape. LandDesigner 3D includes 
wizards to help you design lots, houses, and slopes, for example.



Recommended video display
This program requires at least 256 colors to run. It can also take advantage of thousands or millions of 
colors, but these require more memory. We recommend using these settings only with at least 16MB 
of RAM.

While the program will work fine at 640x480, we recommend at least 800x600, and there are benefits to
1024x768 as well.



Sound
LandDesigner 3D includes music, narration and sound effects. To hear these, you'll need a Windows®-
compatible sound card. If you don't hear sound as you enter Windows, then you may not have 
Windows® sound.



Disclaimer and copyright
© 1997, 1998, 1999 Sierra On-Line, Inc. All rights reserved. 

YOU SHOULD CAREFULLY READ THE FOLLOWING END USER LICENSE AGREEMENT BEFORE 
INSTALLING THIS SOFTWARE PROGRAM. IF YOU DO NOT AGREE WITH THE TERMS OF THIS 
AGREEMENT, YOU MAY NOT INSTALL THE SOFTWARE AND MUST IMMEDIATELY RETURN IT FOR A 
REFUND FROM YOUR RETAILER OR SIERRA.

This software program, any printed materials, any on-line or electronic documentation, and any and all copies 
and derivative works of such software program and materials (the "Program") are the copyrighted work of 
Sierra On-Line, Inc., its subsidiaries, licensors and/or its suppliers. All use of the Program is governed by the 
terms of the End User License Agreement which is provided below ("License Agreement"). The Program is 
solely for use by end users according to the terms of the License Agreement. Any use, reproduction or 
redistribution of the Program not in accordance with the terms of the License Agreement is expressly 
prohibited.

END USER LICENSE AGREEMENT

1. Limited Use License. Sierra On-Line, Inc. ("Sierra") hereby grants, and by installing the Program you 
thereby accept, a limited, non-exclusive license and right to install and use one (1) copy of the Program for
your personal use on either a home or portable computer. You may not network the Program or otherwise 
install it or use it on more than one computer at a time.    The Program is licensed, not sold. Your license 
confers no title or ownership in the Program.

2. Ownership. All title, ownership rights and intellectual property rights in and to the Program and any and all 
copies thereof (including but not limited to any titles, computer code, data, themes, objects, characters, 
character names, stories, text, dialog, catch phrases, locations, concepts, artwork, animations, sounds, 
musical compositions, audio-visual effects, methods of operation, moral rights, any related documentation,
and "applets" incorporated into the Program) are owned by Sierra or its licensors. The Program is 
protected by the copyright laws of the United States, international copyright treaties and conventions and 
other laws. All rights are reserved. The Program may contain certain licensed materials and Sierra's 
licensors may act to protect their rights in the event of any violation of this Agreement.

3. Responsibilities of End User.

A. Subject to the grant of license hereinabove, you may not, in whole or in part, copy, photocopy, reproduce, 
translate, reverse engineer, derive source code from, modify, disassemble, decompile, or create derivative
works based on the Program, or remove any proprietary notices or labels on the Program.

B. The Program is licensed to you as a single product. Its component parts may not be separated for use on 
more than one computer. 

C. You are entitled to use the Program for your own personal use, but you are not entitled to:

(i) sell or transfer reproductions of the Program to other parties in any way, nor to rent, lease or license 
the Program to others;

(ii) exploit the Program or any of its parts for any commercial purpose including, but not limited to, use at 
a cyber café, computer gaming center or any other network or location-based site; or

(iii) host or provide matchmaking services for the Program or emulate or redirect the communication 
protocols used by Sierra in the network feature, if any, of the Program, through protocol emulation, 
tunneling, modifying or adding components to the Program, use of a utility program or any other 
techniques now known or hereafter developed, for any commercial purpose including, but not limited 
to commercial network play over the Internet, network play utilizing commercial gaming networks or 
as part of content aggregation networks.

D.    You must back-up to another secure location, on a regular basis, any data files concerning your use of the 
Program as Sierra has no liability for lost or corrupted data.

4. Program Transfer. You may permanently transfer all of your rights under this License Agreement, provided
the recipient agrees to the terms of this License Agreement and you agree to remove the Program from 
your home or portable computer.

5. Termination. This License Agreement is effective until terminated. You may terminate the License 



Agreement at any time by destroying the Program. Sierra may, at its discretion, terminate this License 
Agreement in the event that you fail to comply with the terms and conditions contained herein. In such 
event, you must immediately destroy the Program.

6. Export Controls. The Program may not be re-exported, downloaded or otherwise exported into (or to a 
national or resident of) any country to which the U.S. has embargoed goods, or to anyone on the U.S. 
Treasury Department's list of Specially Designated Nationals or the U.S. Commerce Department's Table of
Denial Orders. By installing the Program, you are agreeing to the foregoing and you are representing and 
warranting that you are not located in, under the control of, or a national or resident of any such country or
on any such list.

7. Limited Warranty. SIERRA EXPRESSLY DISCLAIMS ANY WARRANTY FOR THE PROGRAM AND 
MANUAL(S). THE PROGRAM AND MANUAL(S) ARE PROVIDED "AS IS" WITHOUT WARRANTY OF 
ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR 
NONINFRINGEMENT. SIERRA FURTHER DISCLAIMS ALL WARRANTIES WITH REGARD TO YEAR 
2000 COMPLIANCE OF THE SOFTWARE. SPECIFICALLY, SIERRA MAKES NO WARRANTIES THAT 
THE PERFORMANCE OR FUNCTIONALITY OF THE PROGRAM WILL NOT BE AFFECTED BY DATES 
PRIOR TO, DURING OR AFTER THE YEAR 2000, OR THAT THE PROGRAM WILL BE CAPABLE OF 
CORRECTLY PROCESSING, PROVIDING, AND/OR RECEIVING DATE INFORMATION WITHIN AND 
BETWEEN CENTURIES, INCLUDING THE PROPER EXCHANGE OF DATE INFORMATION BETWEEN 
PRODUCTS OR APPLICATIONS. ANY WARRANTY AGAINST INFRINGEMENT THAT MAY BE 
PROVIDED IN SECTION 2-312(3) OF THE UNIFORM COMMERCIAL CODE AND/OR IN ANY OTHER 
COMPARABLE STATE STATUTE IS EXPRESSLY DISCLAIMED. The entire risk arising out of use or 
performance of the Program remains with you, however Sierra warrants up to and including 90 days from 
the date of your purchase of the Program that the master disk on which the Program is furnished shall be 
free from defects in material and workmanship. In the event that the master disk proves to be defective 
during that time period, and upon presentation to Sierra of proof of purchase of the defective Program, 
Sierra will at its option 1) correct any defect, 2) provide you with a product of equal or lesser value, or 3) 
refund your money.

8. Limitation of Liability. NEITHER SIERRA, ITS PARENT, SUBSIDIARIES, AFFILIATES OR LICENSORS 
SHALL BE LIABLE IN ANY WAY FOR LOSS OR DAMAGE OF ANY KIND RESULTING FROM THE USE 
OF THE PROGRAM INCLUDING, BUT NOT LIMITED TO, LOSS OF GOODWILL, WORK STOPPAGE, 
COMPUTER FAILURE OR MALFUNCTION, DATA LOSS, DATA CORRUPTION OR ANY AND ALL 
OTHER COMMERCIAL DAMAGES OR LOSSES. Some states do not allow the exclusion or limitation of 
incidental or consequential damages, or allow limitations on how long an implied warranty lasts, so the 
above limitations may not apply to you.

9. Equitable Remedies. You hereby agree that Sierra would be irreparably damaged if the terms of this 
License Agreement were not specifically enforced, and therefore you agree that Sierra shall be entitled, 
without bond, other security, or proof of damages, to appropriate equitable remedies with respect to 
breaches of this License Agreement, in addition to such other remedies as Sierra may otherwise have 
available to it under applicable laws.

10. Miscellaneous. This License Agreement shall be deemed to have been made and executed in the State of
Washington and any dispute arising hereunder shall be resolved in accordance with the law of the State of
Washington. You agree that any claim asserted in any legal proceeding by one of the parties against the 
other shall be commenced and maintained in any state or federal court located in the State of Washington,
King County, having subject matter jurisdiction with respect to the dispute between the parties. This 
License Agreement may be amended, altered or modified only by an instrument in writing specifying such 
amendment, alteration or modification, which is executed by both parties. In the event that any provision of
this License Agreement shall be held by a court or other tribunal of competent jurisdiction to be 
unenforceable, such provision will be enforced to the maximum extent permissible and the remaining 
portions of this License Agreement shall remain in full force and effect. 

You hereby acknowledge that you have read and understand the foregoing License Agreement and agree 
that the action of installing the Program is an acknowledgment of your agreement to be bound by the 
terms and conditions of the License Agreement contained herein. You also acknowledge and agree that 
this License Agreement is the complete and exclusive statement of the agreement between Sierra and 
you and that the License Agreement supersedes any prior or contemporaneous agreement, either oral or 
written (including inconsistent statements in written materials and online help accompanying the Program),
and any other communications between Sierra and you.





Customer support

Sales Support

United States
Sierra Direct U.S.A. Sales Phone: (800) 757-7707
7100 W. Center Rd International Sales:    (425) 746-5771 
STE 301 Hours: Monday-Saturday 7AM to 11 PM CST, 
Omaha, NE    68106 Sundays 8 AM to 9PM CST

 FAX: (402) 393-3224

THE SIERRA NO-RISK GUARANTEE
The Promise: We want you to be happy with every Sierra product you purchase from us. Period. If 
for any reason you're unhappy with the Program, return it within 90 days of your purchase for an 
exchange or a full refund. 

The Only Catch: You've got to tell us why you don't like the Program. Otherwise, we'll never get 
any better.    Send the Program back to us within 90 days of your purchase, postage prepaid, along 
with your original, dated sales receipt and we promise we'll make things right. 
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Tips and tricks

Use layers
The Visible Layers control in Top View lets you show or hide various aspects of your landscape design.
You might want to turn off the display of some items if your machine is running slowly or your design 
becomes congested. Turning off the foliage layer has the greatest effect on speed of processing.

Select small objects below larger ones
If you need help selecting smaller objects when they are positioned below larger ones, right-click on 
the larger object. Choose Select Object from the resulting menu and then select the smaller object’s 
name from the next pop-up menu.

Save the decorations for last
As a rule, don’t add decorations until after the major objects are in place and the right size. You can 
thus experiment freely without having to reposition every small object.

Using vertical and horizontal snap
When you’re dragging an object or a handle on an object, hold down the Shift or Ctrl key while 
dragging. This constrains or “snaps” the movement to a straight line.

Improve printing quality
If you’re printing designs on a black and white printer, the filled-in areas of your design may all print 
black, making it hard to distinguish separate areas. From the Features menu, choose Options to see 
the Options dialog box. Choose the Top View tab and then choose Hide Area Fills to print only 
outlines of the filled-in areas of your landscape.

Improve 3D View speed
Rendering refers to the way LandDesigner 3D creates a three-dimensional effect on a 2D screen. 
Rendering requires a tradeoff between viewing quality and the speed with which LandDesigner 3D 
creates the 3D image.

During the basic design phase of your landscape, you might want to increase the rendering speed at 
the expense of image quality. You can then navigate through the 3D View more quickly, since 
LandDesigner 3D will require less time to generate the 3D scene.

Later, when you want to see all the materials and colors you’ve assigned, you can switch back to a 
better image quality and longer rendering time.

To control rendering speed and image quality:

1. Select Options from the Features menu.
2. Click the 3D View tab in the Options dialog box.
3. To change the rendering method, click one of the following Quality of Scene options:

Full light, all materials. Select this setting to see the highest-quality image, but at the slowest 
rendering speed. This setting is good for viewing your finished design.

Minimal light, all materials. This intermediate setting is a compromise between rendering speed 
and image quality.

Full light, no materials. Select this setting to increase LandDesigner 3D’s rendering speed but 
decrease 3D image quality.



Note: You can also increase rendering speed by clicking the Draft Mode check box, which appears 
in the Mini View when you select the Design phase in the Step-by-step toolbar and then select 
Dynamic F/X.

Improve speed when working with the Object toolbar
The Object toolbar can show photo insets on the icons of specific plants. You can improve speed by 
choosing Options from the Features menu to see the Options dialog box. Choose the Landscape tab
and then choose Hide plant photo insets on the Object toolbar to hide these photo insets. 

Solve memory problems
Because of LandDesigner 3D’s rendering capabilities and other advanced features, the program might
require more memory than some computers can provide. See Solve memory problems for tips on 
conserving your memory resources.

Mixing curves and lines in a shape
You can change a portion of a curve to a line (or vice versa) by right clicking on the diamond shaped 
handles and choosing Change curve/line from the popup menu.    By default the draw tools create 
shapes that contain only curves or only straight lines. 

Having more control over curves
By adding extra “points” to a curve, you will gain    more control and flexibility while reshaping.    Right 
click on a diamond shaped handle and choose Split (add a point) from the popup menu.    This is 
especially useful for a curve that is between two line segments. 

Lock the size and location of large ground objects like lawns and beds
To select and move small objects on top of a larger object without inadvertently moving the large 
object, double-click on the large object and click the Lock Size and Location checkbox (on the Basics 
tab under the 'Height Above Ground' field).

Copying materials in the Material Chooser
It can be tedious to select the same material for multiple areas for the same object.    To copy the 
material shown in one panel of the Spec Sheet to another panel, simply click the first panel, drag the 
mouse to the panel you want to change, and release the mouse.



Learn irrigation basics
Not only will you save water with the right system, you'll save time. Providing enough water, regularly, 
is one of the easiest ways to help your plants thrive. Don't wait till your yard is fully planted to plan the 
whole system. See Using an underground sprinkler system and Choosing drip irrigation in Chapter 3 of
the Design Guide for more information.

Sprinklers
Your first goal in the design process is to position sprinkler heads for overlapping or head-to-head 
coverage. Each spot of ground should be covered by the throw of at least two sprinklers. For full 
coverage in a rectangular area, first place quarter-circle heads in the corners. Then place half-circle 
heads midway along each side. If necessary, set one or more full circle heads along the centerline of 
the area's length.

To design your sprinkler system with LandDesigner 3D, start by taking a sprinkler from the Object 
toolbar and placing it in the Top View. Use the wide variety of sprays and types of sprinklers to make 
sure that your basic irrigation plan covers your entire landscape. You can then resize them in the Top 
View or double-click the sprinkler to use the Spec Sheet.

Pipes
After setting sprinklers, divide the system into pipe circuits. You'll probably need 3/4-inch and 1/2-inch 
PVC pipe for most circuits unless you have a large yard. Be sure to have an experienced irrigation 
installer check your piping plan before you shop. These are the principle rules:

· Don't put plants with different watering needs—lawns and shrubs, for instance—on the same circuit.

· The combined flow of all the heads on a single circuit must not equal more than 75% of the total 
flow rate available.

· All the heads on a circuit must be of the same type. For instance, don't mix spray heads with single-
stream heads.

· After adding sprinklers, follow these steps to add the pipes that will supply water to your sprinklers. 
On the Object toolbar, you have a choice of valves, drains and water pipes. 

Planning Drip 
Drip tubing is usually laid above ground, though it may be buried or mulched. Use buried 3/4-inch PVC
pipe to supply the circuits and 1/2-inch drip tubing above ground, further branching with 1/4-inch tubing
up to 15 feet long. You can use individual emitters or laser-cut 1/4-inch tubing that drips along its entire
length.

If you prefer to use a drip irrigation system, choose from irrigation tubing, several types of drips or a 
bubbler in the Object toolbar.



Review your design
LandDesigner 3D assists you with finding common problems in your design. If you plant a tree too 
close to the house or if your wall height is not up to standard building practices, the review will find the 
problem. 

To use the Design Review:

1. Click the Design Review button on the Finish tab.
2. Click the Problems tab to view the list of problems associated with your design. 
3. Click on the Review All button, located in the lower left-hand corner of your screen, to begin 

the review of your landscape design.
4. Adjust your design to eliminate the problem. 

5. Click the Review All button to refresh your problem list. 

Note: There are several categories of problems the Design Review can look for. Customize the types 
of problems the Design Review looks for by using the Options dialog box in the Features menu. For 
more information, read the Design Review tab.



Import a deck from 3D Deck
You might want to incorporate a deck you’ve created in 3D Deck into your landscape design. 

To export a deck from 3D Deck:

1. In 3D Deck, open the file that you wish to export
2. Move your deck to the appropriate location in your design. 
3. Select File/Export Deck.
4. Enter a name for the file in the File Name field.
5. Click Save to save the file and then exit the 3D Deck program.

To view an imported deck in LandDesigner 3D:

1. Open LandDesigner 3D and open your design file.
Your deck will appear in the Object toolbar under House/Decks.

2. Move your mouse cursor over the thumbnail images to find the deck labeled “Imported 
Deck.”

3. Drag the deck onto your design in Top View.
4. Select the name of the deck you wish to import and click OK.



Take a 3D photo
Take a photo any time you want a high-quality image for your own use or to share with others.

To take a high resolution photo:
1. Use the 3D view controls to show the area you want to record in the photo.
2. Set the time of day and season for your scene.    For more information see Using the Shadow

Caster and Projecting Seasonal Change.
3. Go to the Features menu and select Take Photo/Take a Single 3D Photo.
4. Select the size for your image.

The 160 x 120 pixel size is the smallest image, but is also the quickest to render.    A 1024 x 768 
pixel image is the largest size and takes longest to render. 

5. Click Start to begin taking your photo.
6. When the photo has completed its rendering, click the Save button and name your photo.

Your file will be saved as a .bmp file in the C:\Sierra\Land 3D\Designs directory.

7. To view or print your photo, use an application such as Microsoft Paint.
Note: To take a new photo, close the Take Photo window and reposition your camera to the new 
view.

If you plan to take more than one photo, you might want to first take some snapshots of the images 
and then batch your photos together to render while you’re doing something else.

To batch your photos:

1. Take snapshot(s) of your design.    For more information see Taking snapshots.
2. Go to the Features menu and select Take Photo/Take 3D Photos of Recorded Snapshots.
3. Under the Snapshots menu, select each snapshot you want to take a photo of and click Add.
4. Specify the time of day and season for each photo. Click on each photo in the Files to 

Render menu.    Select the Time (Dawn, Morning, Noon, Afternoon, Dusk or Midnight) and 
Date (Spring, Summer, Fall, Winter).

5. Select the size for each photo.
The 160 x 120 pixel size is the smallest image, but is also the quickest to render.    A 1024 x 768 
pixel image is the largest size and takes longest to render. 

6. Click Start to begin rendering.
7. To view or print your photos, use an application such as Microsoft Paint.

Note: The size if the image is taken from the center of the view.    For example, a 160 x 120 pixel 
image represents the middle 160 x 120 pixels of the view.

 

160 x 120 pixels



 
Same view, 320 x 240 pixels



Quick Start Tutorial
This tutorial introduces you to the basic features of LandDesigner 3D. In five simple steps, you will 
learn to:

· Customize LandDesigner 3D for your area
· Design your site
· Add hardscape, structures, and plants
· Look at your design in 3D
· Connect to the Internet for product updates

If you need additional help during this tutorial, read the Guide text on the left side of the screen to help 
you along.

 

Step 1: How does your garden grow? 



Quick Start Tutorial Step 1

How does your garden grow?

Every gardener knows that what grows well in one place may not even take root in another. The 
Interview phase asks questions pertinent to your growing area so that the plants available later on in 
the Design phase reflect your area’s growing conditions.

1. On the Start tab, click the Interview button and answer the questions about the conditions 
where you live. 

2. Click the Next Step button to step through the two screens of interview questions. 
3. When you have answered all the questions, click the Done button.

Step 2: Design your site 



Quick Start Tutorial Step 2

Design your site

In this lesson you will learn the basics for designing your lot, creating a facsimile of your house and 
adding a driveway. 

1. You should already be in the Site phase of the Step-by-step toolbar. The default lot size is
100’ x 100’.    Change the depth to 80’ and click the Next Step button to continue.

The House Wizard screen appears:

 

2. Click “Use a finished sample home” and choose “Small L-Shaped Traditional” from the 
screen that appears. 

3. Click OK and then click Done.

The house now appears in the middle of the lot. 

4. Click the Roads/Driveway button. Select the first driveway from the Object toolbar. Click 
once near the left rear corner of the house, hold down the mouse button and drag to the 
front of the lot to create a driveway next to the house.



 

5. Click the Design tab to move on to the next section.
Step 3: Add hardscape and structures 



Quick Start Tutorial Step 3

Add hardscape and structures

You will now start to design your landscape. It is easier to begin with the fencing and larger structures 
before adding vegetation.

1. On the Object toolbar, pull down the 3rd level menu and choose Picket. 
2. Select the first fence from the Object toolbar, a curved picket fence. 

For this tutorial, we will place a fence around the outside edge of the lot, leaving a gap for the 
driveway. 

3. Place the fence by clicking once where you want each corner of the fence to be. Press the 
Escape key to end the line. 

4. Click the Structures button. 
5. Go to the Object Bar, and look under the Structures/Yard/Arbors menu.    Click on a 

gazebo.

 
6. Now click once on your lot where you want to build the gazebo and it appears.

Step 4: Add plants 



Quick Start Tutorial Step 4

Add plants

There are two kinds of plants in LandDesigner 3D: generic placeholders and specific varieties. Generic
plants are used to get a general idea of the look you want; each generic plant can later be replaced 
with specific ones.

1. Click the Plants button on the Design tab. 
Generic tree shapes should appear in the Object toolbar. 

2. Select the third tree from the left. We’re going to plant a row of these trees along the left 
property line, so click the Draw Type button on the end of the Object toolbar and select the 
Hedge Draw option. 

 
3. Click once at the front of the property where you want the row of trees to start, then at the 

back of the property where you want the trees to stop.
 LandDesigner 3D automatically determines the number of trees that can fit in that distance.

4. Now add a few flowers near the front of the house. Pull down the second-level menu on the 
Object toolbar and choose Clusters. Place two or three clusters of plants to nicely fill the “L”
of the house. 

5. Let’s complete the design with a nice, lush carpet of lawn grass. Pull down the second-level 
menu on the Object toolbar and choose Lawn Grass. Select the generic shape. 

 

6. Click once in the upper left corner of the lot, hold down the mouse and drag to the lower 
right corner. When you release the mouse button the area you just defined will fill with grass.

Step 5: View your design in 3D 



Quick Start Tutorial Step 5

View your design in 3D

By now, you must be curious to see what your design looks like in 3D view. 

1. To take a look, click on the 3D tab. The controls for walking around in 3D view are located at 
the bottom of the screen.

 

2. Use the cross-shaped navigational arrows to move you through the landscape. Adjust your 
angle by selecting the tilt up or tilt down icons. Adjust viewing height by clicking the 
helicopter or eye-view icons, or by clicking the height arrows.

Step 6: Connect to the Internet 



Quick Start Tutorial Step 6

Connect to the Internet 

Connect to the Internet to receive product updates for LandDesigner 3D.    

1. Select Internet Features from the Features menu or click on the Globe icon on the top of the 
screen. If you have an Internet connection, you will be connected to the LandDesigner 3D 
site. 

2. Once connected you may download new collections of plants and objects to add to your 
program. 

Congratulations! You’ve successfully landscaped your first yard and completed the Quick Start 
Tutorial.    Now you’re ready to design your own landscape.    

What do you want to do?

Navigate the Designer 
Create your design 



Step-by-step toolbar
The Step-by-step toolbar helps you proceed logically through the design process. 



Guide tab
If you need help using any of the design steps in the Step-by-step toolbar, click the Guide tab. For 
narrated, video explanations, click the Media button in the Guide tab.



Top View
The Top View is an aerial, 2D look at your landscape design. Use the Top View to refine your design and 
add plants and other objects. This view appears by default when you open the Designer. 



3D View
The 3D View shows the design in three dimensions. To switch to 3D View from Top View, click the 3D tab 
in the Top View toolbar. Use the WalkAbout features of LandDesigner 3D to stroll around in your design 
and view it from any angle. 



Menu bar
The menu bar contains commands for using LandDesigner 3D. 



Top View toolbar
This toolbar lets you switch between 3D View and Top View, and includes several controls for changing 
the Top View display. For example, you can magnify your view, view or hide certain objects, add text 
notes to your design, and measure distances.



Mini View
When you click the Mini View tab, this window in the upper left corner shows a smaller version of the 
active view. In other words, if the Top View appears in the Designer, a smaller version of the 3D View 
appears in the Mini View.

Note: The Mini View is not always available.



Object toolbar
This toolbar changes depending on whether 3D View or Top View is selected. 



Create your own objects
In some cases, you might want to create your own objects.    If you’re creating an object from a photo, 
you’ll need to translate your photographic image into a bitmap file.

To create a custom object:

1. Select Create a Custom Object from the Custom menu.
The Create a Custom Objects screen appears.

2. Enter a name for your object.
3. Browse for the photo you wish to import.
4. Add the mask to your photo.

You have two options for the mask. You can either use a mask previously created through image 
processing software you may have (such as Photoshop) or create a mask using the following steps 
with the masking feature in the product. 

To use the masking feature, press the Create a Mask button. The Mask Maker window appears.

Use the following tools to mask out the unwanted areas: 

Bucket. Use the bucket to mask out large areas of a similar color, like a sky.    Set the tolerance 
level with a number between 1-100. A lower number selects less pixels because the colors must be 
more similar. A higher number selects more pixels and also runs the risk of selecting your image as 
well. A tolerance level of 15 is good for sky.

Block. Use the block tool to select larger areas of pixels away from the image border.

Pen. The pen tool has a fine point and is useful for masking near the edge of the image. 

To undo masking, right click with any of these tools:

Use the Zoom In and Zoom Out tools to assist you in viewing your work.

Click Done to save your mask and return to the Create a Custom Object window.

5. Enter the dimensions for your object.
6. Choose between upright or horizontal orientation.
7. Click Finish to complete the process.

Your object can be accessed through the Object toolbar under the Your Object Bar menu.



Create your own materials
If you’d like to customize your design, you may import graphics in Windows bitmap (.bmp) format to 
use as materials in your design.

To create a custom material:

1. Select Create a Custom Material from the Custom menu. 
The Create a Custom Material window appears.

2. Click the Browse button for a photo to import. 
3. In the window on the right side of the screen you can view your image as a repeating pattern. 
4. If you’re satisfied with your results, enter a name for your new material and click Finish.

Your new material will appear under the Special/Custom Materials menu in any object’s Materials 
Spec Sheet.

You might want to create a material by using one of LandDesigner 3D’s templates and creating your 
own color combinations.    

To paint your own materials:

1. Select Paint By Numbers from the Custom menu. 
A menu of available patterns appears.

2. Choose your pattern and click the Next button. 
The Paint by Numbers window appears. 

3. The material’s color fields are displayed to the right of the material.    Double click on a color 
you wish to edit.
A color menu will appear.    

4. Choose from the swatches in the Basic Colors on the left or create a custom color by 
clicking within the color spectrum until you achieve the correct hue.

5. Press the Add to Custom Colors button to save your custom color.
6. Select your new color swatch and click OK.
7. Click Finish to complete the process.

Your new material will appear under the Special/Custom Materials menu in any object’s Materials 
Spec Sheet.



Refining your design
This section describes the features that let you refine your design in LandDesigner 3D.

What do you want to do?

Use the Shadow Caster 
Project Seasonal Change 
Project Growth Over Time 
Learn irrigation basics 
Review your design 
Change backgrounds and ground covers 
Import your own background 



Custom menu

Create a 
Custom 
Object This feature gives you the opportunity to bring your own objects into the program. See 

Create your own objects for more information

Create a 
Custom 
Material This feature gives you the opportunity to bring your own materials into the program. See 

Create your own materials for more information.

Paint by 
Numbers This option allows you to create your own color schemes using existing patterns or 

designs from our database. See Create your own materials for more information.



Info tab
This tab displays general information about the selected item. The name and appearance of the tab 
depend on the selected plant or object. If you have access to the Internet, and you selected an object, 
this tab provides several other options for gathering information about the object.

Note: The following options are not available in the Info tab if you selected a plant.

List of Web sites. Below the general information is a list of one or more Web sites that provide more 
information about the object.

Site Review. After selecting a site in the list of Web links, you can click Site Review to read a 
summary of the Web site. 

Connect Now. After selecting a site in the list of Web links, you can click on Connect Now to go 
directly to the Web site. 

Link to Web site. Click this button to connect to our Web site at LandDesigner 3D. It has hundreds of 
additional objects you can download to your computer. 



Hardware acceleration
You can determine if the program is taking advantage of hardware acceleration by choosing Options 
from the Features menu and making sure that “Use 3D Hardware Acceleration” is selected. To turn off
hardware acceleration, uncheck the option and restart the program.



Add Text tool

You can use the Add Text tool in the Top View toolbar to add notes to your design.    

To add notes:
1. Click the Add Text button in the Top View toolbar.

2. Click where in your design you want to add the note. A dialog box will appear.

3. Type the note, choose whether you want the note to include an arrow, then click OK.    

Double-click the label box to edit the note. To move the note, click and drag it to a new location.

Note: Notes do not appear in 3D View.



USDA Hardiness Zones

 




